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บทคัดย่อ 
 คณะผูจ้ดัท าคิดโครงการเพื่อสร้างส่ือเวบ็ไซต์ขนมไทย เพื่อสร้างเวบ็ไซต์ให้คนรุ่นหลงัไดม้า
ศึกษาการท าขนมไทยและท าความเขา้ใจเก่ียวกบัเวบ็ไซตข์นมไทยและท าความเขา้ใจกบัขนมไทยแต่ละ
ภาคสามารถท าไปประกอบอาชีพ หรือ การสอนได ้เหมาะส าหรับผูต้้องการศึกษาเก่ียวกบัตวัโปรแกรม
เบ้ืองตน้ 
 ทางคณะผู ้จดัท าได้มีการใช้โปรแกรม Adobe Dreamweaver Cs6 ใช้ในการออกแบบหน้า
เว็บไซต์ และ ใช้ Adobe Photoshop CS5 ในการออกแบบ Logo Banner ใส่รูปภาพและขอ้ความ ทาง
คณะผูจ้ดัท าไดท้  าการเรียนรู้ดว้ยตนเองพร้อมทั้งท่านอาจารยช่์วยแนะน าในบางส่วนจึงท าใหโ้ครงการน้ี
สมบูรณ์ยิง่ข้ึน 
 โครงการน้ีให้ประโยชน์และความรู้ในการใช้โปรแกรม Adobe Drreamweaver Cs6 กบัทุกคน
ทางคณะผูจ้ดัท าไดมี้การพฒันาตนเองเก่ียวกบัการใชโ้ปรแกรมต่าง ๆ ในการสร้างเวบ็ไซตใ์หอ้อกมาดูดี
และสมบูรณ์ 
       



 

ค 

กติติกรรมประกาศ 

 

 
  เวบ็ไซตข์นมไทยฉบบัน้ีไดจ้ดัท ำข้ึนมำดว้ยควำมตั้งใจและควำมพยำยำมเป็นอยำ่ง
มำกโดยได้รับควำมร่วมมือจำกวิทยำลัยเทคโนโลยีอรรถวิทยพ์ณิชยกำรทุกท่ำนท่ีเก่ียวข้องกับ
โครงกำรฉบบัน้ีไม่วำ่เป็นอำจำรยทุ์กท่ำน 
 ข อขอบพ ระ คุณ อ ำจำรย์พ รธณ ำ  เจื อ จ ำรย์  ท่ี ป รึก ษ ำห ลัก โค รงก ำร  
และอำจำรยน์รำภรณ์  บวันุช  ท่ีปรึกษำร่วมโครงกำร ท่ีได้ให้กำรสนับสนุน ให้ควำมช่วยเหลือ
รวมทั้งค  ำปรึกษำตกัเตือนส่วนท่ีผิดพลำดของโครงกำรน้ี ขอขอบคุณวทิยำลยัเทคโนโลยีอรรถวิทย์
พณิชยกำร ท่ีไดใ้ห้สถำนท่ีในกำรจดัท ำอินเทอร์เน็ตส ำหรับนกัศึกษำ พร้อมทั้งขอขอบพระคุณท่ำน
คณะกรรมกำรในกำรสอบท่ีให้ค  ำติชมในกำรสอบวิชำโครงกำร เพื่อท่ีคณะผูจ้ ัดท ำได้น ำไป
ปรับปรุงแกไ้ขในส่วนท่ีบกพร่องใหดี้ข้ึนเพื่อท่ีโครงกำรคร้ังน้ีจะไดอ้อกมำอยำ่งสมบูรณ์ 
 ขอขอบคุณผูป้กครองคณะผูจ้ดัท ำทุกท่ำนท่ีคอยให้ก ำลังใจและให้โอกำสใน
กำรศึกษำท่ีวิทยำลยัเทคโนโลยีอรรถวิทยพ์ณิชยกำร รวมทั้งเพื่อนๆ ปวช.3/9 ทุกคนท่ีคอยช่วยให้
ค  ำปรึกษำและคอยใหก้ ำลงัใจ 
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 การจดัท าโครงการน้ี เป็นส่วนหน่ึงของวิชาโครงการ รหัสวิชา 2204-8501  หลักสูตร
ประกาศนียบตัรวิชาชีพ สาขาวิชาคอมพิวเตอร์ธุรกิจ โดยคณะผูจ้ดัท าได้จดัท าโครงการประเภท 
เวบ็ไซต ์เร่ือง ขนมไทยโดยมีการสร้างเวบ็ไซตเ์พื่อน าเสนอผลงานแก่ผูท่ี้สนใจในเวบ็ไซตข์นมไทย  

เว็บไซต์ท่ีทางคณะผูจ้ดัท าได้จดัท านั้ น ประกอบไปด้วยความรู้เก่ียวกับขนมไทย และ
วิธีการท าส่วนผสมของขนมไทย ขนมไทยเป็นขนมท่ีน่าสนใจและเขา้ถึงขนมไทยไดอ้ยา่งแทจ้ริง 
ขนมไทยมีความส าคญัต่อคนไทย และสามารถเอาไปใชใ้นพิธีการส าคญัต่าง ๆ ของคนไทย เช่น พิธี
งานแต่งงาน งานบวช และงานบุญต่าง ๆ และขนมไทยมีประวติัความเป็นมาเป็นท่ีมาน่าสนใจอยา่ง
ยิง่และวิธีการท่ีสืบต่อกนัมารุ่นต่อรุ่น จึงยกเร่ืองขนมไทยข้ึนมาใหม่เพื่อใหท้ั้งน้ีการท าเวบ็ไซตข์นม
ไทยตั้งแต่สมยัอดีตจนถึงปัจจุบนัโดยเวบ็ไซต์แสดงเน้ือหาเก่ียวกบัขนมไทยแต่ละชนิด เพื่อแสด
ออกในรูปแบบของเว็บไซต์โดยเว็บไซต์ได้มีการเช่ือมขอ้มูลของเพจแต่ละเพจเขา้ด้วยกันอย่าง
สมบูรณ์ 
 หากโครงการน้ีมีข้อผิดพลาดประการใด ทางคณะผู ้จ ัดท า ขออภัยไว ้ณ ท่ีน้ี และจะ
ด าเนินการพฒันาผลงานทางดา้นคอมพิวเตอร์ใหพ้ฒันาใหดี้ข้ึนไป  
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บทที ่1 
บทน ำ 

 
1.1 ภูมิหลงัและควำมเป็นมำ 

ปัจจุบนัเทคโนโลยีคอมพิวเตอร์เขา้มามีบทบาทส าคญัต่อการส่ือสาร ทั้งด้านการศึกษา 
ดา้นธุรกิจด้านกฎหมาย ฯลฯ โดยเทคโนโลยีได้มีการพฒันาให้มีประสิทธิภาพเพื่อรองรับความ
ตอ้งการของผูใ้ช้ในยุคดิจิทลั ซ่ึงมีการเขา้ถึงขอ้มูลต่าง ๆ ได้อย่างรวดเร็วด้วยเหตุน้ีจึงเป็นปัจจยั
ส าคญัท่ีท าให้บุคคลทัว่ไปไดเ้ห็นถึงความจ าเป็นของเทคโนโลยีคอมพิวเตอร์ ทั้งรูป รูปแบบการ
น าเสนอแบบเวบ็ไซต์มลัติมีเดีย และสารสนเทศทัว่ไปท่ีปัจจุบนัไดมี้การน าเสนอส่ือท่ีน่าสนใจทั้ง
ในยุคปัจจุบนัและอนาคต สร้างเวบ็ไซต์หรือสนับสนุนให้มีการรับเวบ็ไซต์มีความส าคญัอย่างไร
โดยเฉพาะองคก์ารธุรกิจ ปัจจุบนัเวบ็ไซตเ์ปรียบเสมือนส่ิงหน่ึงท่ีไม่อาจขาดได ้

ขนมไทยเป็นขนมท่ีน่าสนใจและเขา้ถึงขนมไทยไดอ้ยา่งแทจ้ริง ขนมไทยมีความส าคญัต่อ
คนไทย และสามารถเอาไปใช้ในพิธีการส าคญัต่าง ๆ ของคนไทย เช่น พิธีงานแต่งงาน งานบวช 
และงานบุญต่าง ๆ และขนมไทยมีประวติัความเป็นมาเป็นท่ีมาน่าสนใจอยา่งยิ่งและวธีิการท่ีสืบต่อ
กนัมารุ่นต่อรุ่น จึงยกเร่ืองขนมไทยข้ึนมาใหม่เพื่อให้ทั้งน้ีการท าเวบ็ไซต์ขนมไทยตั้งแต่สมยัอดีต
จนถึงปัจจุบนัโดยเวบ็ไซต์แสดงเน้ือหาเก่ียวกบัขนมไทยแต่ละชนิด เพื่อแสดออกในรูปแบบของ
เวบ็ไซตโ์ดยเวบ็ไซตไ์ดมี้การเช่ือมขอ้มูลของเพจแต่ละเพจเขา้ดว้ยกนัอยา่งสมบูรณ์ 
 ดงันั้นคณะผูจ้ดัท าจึงไดค้  านึงถึงความส าคญัของการน าเสนอขอ้มูลเก่ียวกบัขนมไทยแต่ละ
ชนิดของขนมไทยรวมทั้งมีเอกลกัษณ์ดา้นวฒันธรรมประจ าชาติไทยมีความละเอียดอ่อนประณีตใน
การเลือกสรรวตัถุดิบ วิธีการท าท่ีพิธีพิถนั รสชาติอร่อยหอมหวาน สีสันสวยงาม รูปลกัษณ์ชวนน่า
รับประทาเพื่อเผยแพร่องคค์วามรู้ใหบุ้คนรุ่นหลงัไดเ้ห็นถึงขนมประจ าชาติ 
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1.2 วตัถุประสงค์ของโครงกำร 

1. เพื่อสร้างเวบ็ไซต ์“ขนมไทย” 
2. เพื่อส่งเสริมใหค้นไทยรู้จกัขนมไทยมากข้ึน 
3. เพื่ออนุรักษข์นมไทยใหค้งอยูก่บัประเทศไทยต่อไป 

 
1.3 ขอบเขตกำรศึกษำ 
 1.    มีการแทรกวิดีโอเวบ็ไซต ์
 2.    มีการแทรกเสียงในเวบ็ไซต ์
 3.    มีการแทรก Rollover  Image  
1.4 ประโยชน์ทีค่ำดว่ำจะได้รับ 

1.   ไดเ้วบ็ไซตเ์ก่ียวกบัขนมไทย 
 2.   ไดรู้้จกัการน าไปใชป้ระโยชน์การเลือกขนมไทย 

3.   ไดน้ าความรู้ไปใชใ้นชีวิตประจ าวนัไดแ้ละสามารถน าไปสอน หรือ ประกอบอาชีพก็ 
ได ้
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1.5 แผนกำรด ำเนินงำน (Gantt Chart) 

ตำรำงที ่1.1  แผนการด าเนินงาน (Gantt Chart) 
 

รำยกำร ภำคเรียนที ่1 
มถุินำยน 62 กรกฎำคม 62 สิงหำคม 62 กนัยำยน 62 

ระยะเวลำ 
1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 

อบรมการท าโครงการ
นกัศึกษา  ปวช.3 และปวส.2 

                11-12 มิถุนายน 62 

เสนอหวัขอ้ ATC.01โครงการ 
รอบท่ี 1 (บทท่ี1+ลงทะเบียน
ออนไลน์)  

                14 มิถุนายน -3 
กรกฎาคม  62 

ประกาศผลหวัขอ้โครงการ 
รอบท่ี 1 

                5  กรกฎาคม 62 

เสนอหวัขอ้โครงการ รอบท่ี 2                 6  กรกฎาคม 62 

ประกาศผลหวัขอ้โครงการ 
รอบท่ี 2 

                9  กรกฎาคม 62 

ส่งบทท่ี 2                 18-25 กรกฎาคม 62 

ส่งบทท่ี 3                 1-17 สิงหาคม 62 

สอบหวัขอ้โครงการ  
(รอบเอกสาร) 

                20-24 สิงหาคม 62 

ประกาศผลสอบ                 29 สิงหาคม 62 

ส่งความคืบหนา้โปรแกรม  
50% 

                10-16 กนัยายน 62 

ส่งความคืบหนา้โปรแกรม 
60% 

                17-23 กนัยายน 62 

ส่งความคืบหนา้โปรแกรม 
70% 

                24-30 กนัยายน 62 

รำยกำร ภำคเรียนที ่2 
พฤศจกิำยน 62 ธันวำคม 62 มกรำคม 63 กมุภำพนัธ์ 63 ระยะเวลำ 

1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 
ส่งความคืบหนา้ 90%                 2 พฤศจิกายน 62 

ส่งความคืบหนา้ 100%                 9 พฤศจิกายน 62 

สอบโปรแกรม ระดบัปวส.2                  10 พฤศจิกายน 62 

สอบโปรแกรม ระดบั ปวช.3                 24 พฤศจิกายน 62 

ส่งบทท่ี 4                  11-21 ธนัวาคม 62 

ส่งบทท่ี 5                 14-26  มกราคม 63 

ส่งรูปเล่ม ซีดี และค่าเขา้เล่ม                 27 มกราคม – 
 3 กุมภาพนัธ์ 2563 
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1.6 เคร่ืองมือทีใ่ช้พฒันำโปรแกรม 

1. โปรแกรม Adobe Dreamweaver CS5 ใชส้ าหรับการเช่ือมเวบ็ไซต ์
2. โปรแกรม Adobe Photoshop CS6 ใชส้ าหรับตดั ตกแต่งรูป 
3. โปรแกรม Microsoft word 2016 ใชส้ าหรับพิมพร์ายงาน 

 
1.7 งบประมำณกำรด ำเนินงำน  

 

ล ำดับ รำยกำร จ ำนวน รำคำ (บำท) 
1 กระดาษ A4 1 รีม 240 
2 ค่าปร้ิน 1 รีม 600 
3 ค่ารวมเล่ม 1 เล่ม  200 
4 ค่าCD 2 แผน่ 40 

รวมเป็นเงิน 1,100 

 
ตำรำงที ่1.2 งบประมาณการด าเนินงาน 

 
                        

 
 
 
 
 
 
 
 
 
 
 
 
 



 

บทที ่2 

ระบบทฤษฎทีี่เกีย่วข้อง 

 

2.1 ระบบงานและทฤษฎทีีเ่กีย่วข้อง        

ปัจจุบนัเทคโนโลยีคอมพิวเตอร์เขา้มามีบทบาทส าคญัต่อการส่ือสาร ทั้งด้านการศึกษา 
ดา้นธุรกิจด้านกฎหมาย ฯลฯ โดยเทคโนโลยีได้มีการพฒันาให้มีประสิทธิภาพเพื่อรองรับความ
ตอ้งการของผูใ้ช้ในยุคดิจิทัล ซ่ึงมีการเขา้ถึงขอ้มูลต่าง ๆ ได้อย่างรวดเร็วด้วยเหตุน้ีจึงเป็นปัจจยั
ส าคญัท่ีท าให้บุคคลทัว่ไปไดเ้ห็นถึงความจ าเป็นของเทคโนโลยีคอมพิวเตอร์ ทั้งรูป รูปแบบการ
น าเสนอแบบเวบ็ไซต์มลัติมีเดีย และสารสนเทศทัว่ไปท่ีปัจจุบนัไดมี้การน าเสนอส่ือท่ีน่าสนใจทั้ง
ในยุคปัจจุบนัและอนาคต สร้างเวบ็ไซต์หรือสนบัสนุนให้มีการรับเวบ็ไซต์มีความส าคญัอย่างไร
โดยเฉพาะองคก์ารธุรกิจ ปัจจุบนัเวบ็ไซตเ์ปรียบเสมือนส่ิงหน่ึงท่ีไม่อาจขาดได ้

ขนมไทยเป็นขนมท่ีน่าสนใจและเขา้ถึงขนมไทยไดอ้ยา่งแทจ้ริง ขนมไทยมีความส าคญัต่อ
คนไทย และสามารถเอาไปใช้ในพิธีการส าคญัต่าง ๆ ของคนไทย เช่น พิธีงานแต่งงาน งานบวช 
และงานบุญต่าง ๆ และขนมไทยมีประวติัความเป็นมาเป็นท่ีมาน่าสนใจอยา่งยิ่งและวธีิการท่ีสืบต่อ
กนัมารุ่นต่อรุ่น จึงยกเร่ืองขนมไทยข้ึนมาใหม่เพื่อให้ทั้งน้ีการท าเวบ็ไซต์ขนมไทยตั้งแต่สมยัอดีต
จนถึงปัจจุบนัโดยเวบ็ไซต์แสดงเน้ือหาเก่ียวกบัขนมไทยแต่ละชนิด เพื่อแสดออกในรูปแบบของ
เวบ็ไซตโ์ดยเวบ็ไซตไ์ดมี้การเช่ือมขอ้มูลของเพจแต่ละเพจเขา้ดว้ยกนัอยา่งสมบูรณ์ 

ดงันั้นคณะผูจ้ดัท าจึงไดค้  านึงถึงความส าคญัของการน าเสนอขอ้มูลเก่ียวกบัขนมไทยแต่ละ
ชนิดของขนมไทยรวมทั้งมีเอกลกัษณ์ดา้นวฒันธรรมประจ าชาติไทยมีความละเอียดอ่อนประณีตใน
การเลือกสรรวตัถุดิบ วิธีการท าท่ีพิธีพิถนั รสชาติอร่อยหอมหวาน สีสันสวยงาม รูปลกัษณ์ชวนน่า
รับประทาเพื่อเผยแพร่องคค์วามรู้ใหบุ้คนรุ่นหลงัไดเ้ห็นถึงขนมประจ าชาติ 
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2.2 ปัญหาระบบงานในปัจจุบัน 

 1.ปัจจุบนักลุ่มผูท่ี้จะศึกษาเก่ียวกบัขนมไทยยงัเขา้ถึงขอ้มูลไม่ชดัเจน 
2.เน้ือหาท่ีน ามารวบรวมกันบางอย่างก็ไม่ประติดประต่อกันหรือบางอย่างเน้ือหาก็ไม่

ตรงกนั 
3.ในบางเวบ็ไซตอ์าจน าเสนอไม่เขา้ใจหรือขอ้มูลและรูปภาพขดัขอ้ง 
4.การศึกษาเน้ือหาจากหนงัสือเพียงอยา่งเดียวนั้นไม่ค่อยมีความน่าสนใจเน่ืองจากรูปและสี

ในการน าเสนอนอ้ย 
5.การเผยแพร่ขอ้มูลมีนอ้ยไม่กวา้งขวาง 

2.3ทฤษฎทีีเ่กีย่วข้อง 

หลกัการออกแบบเน้ือหา 

เวบ็ไซต ์หมายถึง หนา้เวบ็หลายหน้า ซ่ึงเช่ือมโยงกนัผา่นทางไฮเปอร์ลิงก์ ส่วนใหญ่จดัท า
ข้ึนเพื่อน าเสนอขอ้มูลผ่านคอมพิวเตอร์ โดยถูกจดัเก็บไวใ้นเวิลด์ไวด์เวบ็ หน้าแรกของเวบ็ไซต์ท่ี
เก็บไวท่ี้ช่ือหลกัจะเรียกว่า โฮมเพจ เว็บไซต์โดยทัว่ไปจะใช้เพื่อท่ีจะดูขอ้มูล ในเว็บไซต์นั้น ซ่ึง
ไดแ้ก่ขอ้มูลทางวิชาการ ขอ้มูลตลาดหลกัทรัพย ์หรือขอ้มูลส่ือต่าง ๆการเรียกดูเวบ็ไซต์โดยทัว่ไป
นิยมเรียกดูผา่นซอฟตแ์วร์ในลกัษณะของเวบ็ไซต ์

องค์ประกอบทีค่วรพจิารณาในการจัดท าเวบ็ไซต์มีดังนี้ 

1.ความเรียบง่าย (Simplicity) หมายถึง การจ ากัดองค์ประกอบเสริมให้เหลือเฉพาะ
องค์ประกอบหลัก กล่าวคือในการส่ือสารเน้ือหากบัผูใ้ช้นั้น เราตอ้งเลือกเสนอส่ิงท่ีเราต้องการ
น าเสนอจริง ๆ ออกมาในส่วนของกราฟิก สีสัน ตวัอกัษรและภาพเคล่ือนไหวตอ้งเลือกให้พอเหมาะ
ถา้หากมีมากเกินไปจะรบกวนสายตาและสร้างความล าคาญต่อผูใ้ช้ ตวัอย่างเว็บไซต์ท่ีได้รับการ
ออกแบบท่ีดีไดแ้ก่ เวบ็ไซตข์องบริษทัใหญ่ ๆ อยา่งเช่นApple Adobe Microsoft หรือ Kokia ท่ีมีการ
ออกแบบเวบ็ไซตใ์นรูปแบบท่ีเรียบง่าย ไม่ซบัซอ้น และใชง้านสะดวก 

2. ความสม ่าเสมอ (Consistency) หมายถึง การสร้างความสม ่าเสมอให้เกิดข้ึนตลอดทั้ง
เว็บไซต์ โดยอาจเลือกใช้รูปแบบเดียวกันตลอดทั้ งเว็บไซต์ก็ได้ เพราะถ้าหากว่าแต่ละหน้าใน
เวบ็ไซตน์ั้นมีความแตกต่างกนัมากจนเกินไป อาจท าใหผู้ใ้ชเ้กิดความสับสนและไม่แน่ใจวา่ก าลงัอย
ในเวบ็ไซต์เดิมหรือไม่ เพราะฉะนั้นการออกแบบเวบ็ไซต์ในแต่ล่ะหน้าควรท่ีจะมีรูปแบบ สไตล์
ของกราฟิก ระบบเนวเิกชัน่ (Navigation) และโทนสีท่ีมีความคลา้ยคลึงกนัตลอดทั้งเวบ็ไซต ์
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3. ความเป็นเอกลกัษณ์ (Identity)ในการออกแบบเวบ็ไซตต์อ้งค านึงถึงลกัษณะขององคก์ร
เป็นหลกั เน่ืองจากเวบ็ไซต์จะสะทอ้นถึงเอกลกัษณ์และลกัษณะขององค์กร การเลือกใช้ตวัอกัษร 
ชุดสี รูปภาพหรือกราฟิก จะมีผลต่อรูปแบบของเว็บไซต์เป็นอย่างมาก ตวัอย่างเช่น ถ้าเราต้อง
ออกแบบเวบ็ไซต์ของธนาคารแต่เรากลบัเลือกสีสันและกราฟิกมากมาย อาจท าให้ผูใ้ช้คิดว่าเป็น
เวบ็ไซตข์องสวนสนุกซ่ึงส่งผลต่อความเช่ือถือขององคก์รได ้

4. เน้ือหา (Useful Content)ถือเป็นส่ิงส าคัญท่ีสุดในเว็บไซต์ เน้ือหาในเว็บไซต์ต้อง
สมบูรณ์และไดรั้บการปรับปรุงพฒันาให้ทนัสมยัอยูเ่สมอ ผูพ้ฒันาตอ้งเตรียมขอ้มูลและเน้ือหาท่ี
ผูใ้ชต้อ้งการใหถู้กตอ้งและสมบูรณ์ เน้ือหาท่ีส าคญัท่ีสุดคือเน้ือหาท่ีทีมผูพ้ฒันาสร้างสรรคข้ึ์นมาเอง 
และไม่ไปซ ้ ากบัเวบ็อ่ืน เพราะจะถือเป็นส่ิงท่ีดึงดูดผูใ้ช้ให้เขา้มาเวบ็ไซต์ไดเ้สมอ แต่ถา้เป็นเวบ็ท่ี
ลิงค์ขอ้มูลจากเวบ็อ่ืน ๆ มาเม่ือใดก็ตามท่ีผูใ้ชท้ราบวา่ ขอ้มูลนั้นมาจากเวบ็ใด ผูใ้ช้ก็ไม่จ  าเป็นตอ้ง
กลบัมาใชง้านลิงคเ์หล่านั้นอีก 

5. ระบบเนวิเกช่ัน (User-Friendly Navigation)เป็นส่วนประกอบท่ีมีความส าคัญต่อ
เว็บไซต์มาก เพราะจะช่วยไม่ให้ผู ้ใช้เกิดความสับสนระหว่างดูเว็บไซต์ ระบบเนวิเกชั่นจึง
เปรียบเสมือนป้ายบอกทาง ดงันั้นการออกแบบเนวิเกชัน่ จึงควรให้เขา้ใจง่าย ใชง้านไดส้ะดวก ถา้มี
การใช้กราฟิกก็ควรส่ือความหมาย ต าแหน่งของการวางเนวิเกชั่นก็ควรวางให้สม ่าเสมอ เช่น อยู่
ต  าแหน่งบนสุดของทุกหน้าเป็นตน้ ซ่ึงถา้จะให้ดีเม่ือมีเนวิเกชัน่ท่ีเป็นกราฟิกก็ควรเพิ่มระบบเนวิ
เกชัน่ท่ีเป็นตวัอกัษรไวส่้วนล่างดว้ย เพื่อช่วยอ านวยความสะดวกให้กบัผูใ้ช้ท่ียกเลิกการแสดงผล
ภาพกราฟิกบนเวบ็เบราเซอร์ 

6. คุณภาพของส่ิงที่ปรากฏให้เห็นในเว็บไซต์ (Visual Appeal)ลักษณะท่ีน่าสนใจของ
เวบ็ไซตน์ั้น ข้ึนอยูก่บัความชอบส่วนบุคคลเป็นส าคญั แต่โดยรวมแลว้ก็สามารถสรุปไดว้า่เวบ็ไซต์
ท่ีน่าสนใจนั้นส่วนประกอบต่าง ๆ ควรมีคุณภาพ เช่น กราฟิกควรสมบูรณ์ไม่มีรอยหรือขอบขั้นบนั
ไดใ้หเ้ห็น ชนิดตวัอกัษรอ่านง่ายสบายตา มีการเลือกใชโ้ทนสีท่ีเขา้กนัอยา่งสวยงาม เป็นตน้ 

7. ความสะดวกของการใช้ในสภาพต่าง ๆ (Compatibility) การใชง้านของเวบ็ไซต์นั้นไม่
ควรมีขอบจ ากดั กล่าวคือ ตอ้งสามารถใชง้านไดดี้ในสภาพแวดลอ้มท่ีหลากหลายไม่มีการบงัคบัให้
ผูใ้ชต้อ้งติดตั้งโปรแกรมอ่ืนใดเพิ่มเติม นอกเหนือจากเวบ็บราวเซอร์ควรเป็นเวบ็ท่ีแสดงผลไดดี้ใน
ทุกระบบปฏิบัติการ สามารถแสดงผลได้ในทุกความละเอียดหน้าจอ ซ่ึงหากเป็นเว็บไซต์ท่ีมี
ผูใ้ชบ้ริการมากและกลุ่มเป้าหมายหลากหลายควรใหค้วามส าคญักบัเร่ืองน้ีใหม้าก 
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8. ความคงที่ในการออกแบบ (Design Stability)ถ้าตอ้งการให้ผูใ้ช้งานรู้สึกว่าเว็บไซต์มี
คุณภาพ ถูกต้อง และเช่ือถือได้ ควรให้ความส าคญักบัการออกแบบเว็บไซต์เป็นอย่างมาก ต้อง
ออกแบบวางแผนและเรียบเรียงเน้ือหาอยา่งรอบคอบ ถา้เวบ็ท่ีจดัท าข้ึนอยา่งลวก ๆ ไม่มีมาตรฐาน
การออกแบบและระบบการจดัการขอ้มูล ถา้มีปัญหามากข้ึนอาจส่งผลให้เกิดปัญหาและท าให้ผูใ้ช้
หมดความเช่ือถือ 

9. ความคงทีข่องการท างาน (Function Stability)ระบบการท างานต่าง ๆ ในเวบ็ไซตค์วรมี
ความถูกตอ้งแน่นอน ซ่ึงตอ้งได้รับการออกแบบสร้างสรรค์และตรวจสอบอยู่เสมอ ตวัอย่างเช่น 
ลิงคต่์าง ๆ ในเวบ็ไซต ์ตอ้งตรวจสอบวา่ยงัสามารถลิงคข์อ้มูลไดถู้กตอ้งหรือไม่ เพราะเวบ็ไซตอ่ื์น
อาจมีการเปล่ียนแปลงไดต้ลอดเวลา ปัญหาท่ีเกิดจากลิงค ์ก็คือ ลิงคข์าด ซ่ึงพบไดบ้่อยเป็นปัญหาท่ี
สร้างความร าคาญกบัผูใ้ชเ้ป็นอยา่งมาก 

ส่ิงทีผู้่ใช้ต้องการจากเวบ็ 

หลงัจากท่ีได้เป้าหมายและกลุ่มเป้าหมายของเว็บไซต์แล้ว ล าดบัต่อไปคือการออกแบบ
เวบ็ไซตเ์พื่อดึงดูดผูใ้ชง้านให้ไดน้านท่ีสุด ดว้ยการสร้างส่ิงท่ีน่าสนใจเพื่อดึงดูดผูใ้ชโ้ดยทัว่ไปแลว้ 
ส่ิงท่ีผูใ้ชค้าดหวงัจากการเขา้ชมเวบ็ไซตห์น่ึง ไดแ้ก่ 

- ขอ้มูลและการใชง้านท่ีเป็นประโยชน์ 
- ข่าวและขอ้มูลท่ีน่าสนใจ 
- การตอบสนองต่อผูใ้ช ้
- ความบนัเทิง 

ข้อมูลหลกัทีค่วรมีอยู่ในเวบ็ไซต์ 

เม่ือเราทราบถึงความต้องการท่ีผูใ้ช้ต้องการได้รับเม่ือเข้าชมเว็บไซต์หน่ึง ๆ แล้ว เราก็
ออกแบบเว็บไซต์ให้มีขอ้มูลท่ีผูใ้ช้ตอ้งการ ซ่ึงขอ้มูลต่อไปน้ี เป็นส่ิงท่ีผูใ้ช้ส่วนใหญ่คาดหวงัจะ
ไดรั้บเม่ือเขา้ไปชมเวบ็ไซต ์

- ขอ้มูลเก่ียวกบัขนมไทย 
- รายละเอียดของขนมไทย 
- ข่าวความคืบหนา้ของขนมไทย 
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ความรู้เบื้องต้นเกีย่วกบัสี 

 ทุกคนคงไดรู้้จกัแม่สีหรือสีขั้นตน้ ( primary color ) ทั้งสามซ่ึงประกอบดว้ย สีแดง,เหลือง 
และน ้ าเงิน มาก่อนจากการศึกษาในอดีต เหตุท่ีสีทั้งสามน้ีถือว่าเป็นแม่สีหลกั ก็เพราะว่าสีทั้งสาม
เป็นสีท่ีไม่สามารถเกิดข้ึนจากการผสมของสีอ่ืน ๆ และยงัเป็นตน้ก าเนิดของสีอ่ืน ๆท่ีเหลือทั้งหมด 
ต่อไปก็เป็นสีขั้นท่ี 2 ท่ีเกิดจากการผสมของสีขั้นตน้เขา้ดว้ยกนั โดยท่ี สีแดงกบัสีเหลืองไดเ้ป็นสีส้ม
,สีเหลืองกบัน ้ าเงินไดเ้ป็นเขียว และสีน ้าเงินกบัแดงไดเ้ป็นม่วง ต่อจากนั้นก็เป็นสีขั้นท่ี 3 ซ่ึงเกิดจาก
การผสมของสีขั้นตน้กบัสีขั้นท่ี 2 ท่ีอยูติ่ดกนัทั้งสองดา้น ในท่ีสุดเราก็จะไดสี้ขั้นท่ี 3 ทั้งหมด 6 สี 
โดยสีขั้นตน้ 1 สี ท าใหเ้กิดสีขั้นท่ีสาม 2 สี ดงัน้ี : เหลือง-ส้ม , แดง-ส้ม , แดง-ม่วง , น ้ าเงิน-ม่วง ,น ้ า
เงิน-เขียว และเหลือง-เขียว เม่ือเรารู้ท่ีมาของสีต่างๆดีแลว้ ในขั้นต่อไปจะเป็นเร่ืองของพื้นฐานการ
ผสมสี การจดัระบบสี และรูปแบบของชุดสีพื้นฐาน 

แสดงตวัอยา่งสีขั้นต่างๆ 

 

 

สีขั้นท่ี 1                  สีขั้นท่ี 2 

 

    

สีขั้นท่ี 3                  สีขั้นท่ี 4 

รูปที ่2.1 รูปแสดงโครงสร้างการผสมสี 

ประโยชน์ของสีในรูปแบบต่างๆ มีดังนี ้

-สีสามารถชักน าสายตาผูอ่้านให้ไปยงัทุกบริเวณในหน้าเวบ็เพจ ผูอ่้านจะมีการเช่ือมโยง
ความรู้สึกกบับริเวณของสีในรูปแบบท่ีคาดหวงัได ้การเลือกเฉดสีและต าแหน่งของสีอยา่งรอบคอบ
ในหนา้เวบ็ สามารถน าทางให้ผูอ่้านติดตามเน้ือหาในบริเวณต่างๆ ตามท่ีเราก าหนดได ้วิธีน้ีจะเป็น
ประโยชน์อย่างมากเม่ือคุณตอ้งการให้ผูอ่้านให้ความสนใจกับส่วนใดส่วนหน่ึงในเว็บไซต์เป็น
พิเศษ เช่น ขอ้มูลใหม่ โปรโมชัน่พิเศษ หรือบริเวณท่ีไม่ค่อยไดรั้บความสนใจมาก่อน 
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-สีช่วยเช่ือมโยงบริเวณท่ีไดรั้บการออกแบบเขา้ดว้ยกนั ผูอ่้านจะมีความรู้สึกวา่บริเวณท่ีมีสี
เดียวกนัจะมีความส าคญัเท่ากนั วิธีการเช่ือมโยงแบบน้ีช่วยจดักลุ่มของขอ้มูลท่ีมีความสัมพนัธ์อยา่ง
ไม่เด่นชดัเขา้ดว้ยกนัได ้

-สีสามารถน าไปใช้ในการแบ่งบริเวณต่างๆ ออกจากกัน ท านองเดียวกับการเช่ือมโยง
บริเวณท่ีมีสีเหมือนกนัเขา้ดว้ยกนัในขณะเดียวกนัก็เป็นการแบ่งแยกบริเวณท่ีมีสีต่างกนัออกจากกนั 

-สีสามารถใช้ในการดึงดูดความสนใจของผูอ่้านสายตาผูอ่้านมกัจะมองไปยงัสีท่ีมีลกัษณะ
เด่น หรือผิดปกติเสมอ การออกแบบเวบ็ไซต์ด้วยการเลือกใช้สีอย่างรอบคอบ ไม่เพียงแต่จะกระตุน้
ความสนใจของผูอ่้านเพียงเท่านั้น แต่ยงัช่วยหน่วงเหน่ียวให้พวกเขาอยูใ่นเวบ็ไซตไ์ดน้านยิ่งข้ึน ส่วน
เวบ็ไซตท่ี์ใชสี้ไม่เหมาะสม เสมือนเป็นการขบัไล่ผูช้มไปสู่เวบ็อ่ืนท่ีมีการออกแบบท่ีดีกวา่ 

-สีสามารถสร้างอารมณ์โดยรวมของเวบ็เพจ และกระตุน้ความรู้สึกตอบสนองจากผูช้มได้
นอกเหนือจากความรู้สึกท่ีไดรั้บจากสีตามหลกัจิตวิทยาแล้ว ผูช้มยงัอาจมีอารมณ์และความรู้สึก
สัมพนัธ์กบัสีบางสีหรือบางกลุ่มเป็นพิเศษ 

-สีช่วยสร้างระเบียบใหก้บัขอ้ความต่างๆ เช่น การใชสี้แยกส่วนระหวา่งหวัเร่ืองกบัตวัเร่ือง 
หรือการสร้างความแตกต่างให้กบัข้อความบางส่วน โดยใช้สีแดงส าหรับค าเตือน หรือใช้สีเทา
ส าหรับส่ิงท่ีเป็นทางเลือกนอกเหนือจากการใช้สีช่วยในการออกแบบแล้วสียงัสามารถส่งเสริม
เอกลกัษณ์ขององค์กรหรือหน่วยงานนั้นๆ ได ้ใช้สีท่ีเป็นเอกลกัษณ์ขององค์กรมาเป็นโทนสีหลกั
ของเวบ็ไซต ์

-การออกแบบเก่ียวกบัสีไม่ใช่เร่ืองง่าย แมว้่าจะมีกฎเกณฑ์ต่างๆ ท่ีช่วยในการสร้างชุดสี  
(color scheme) ท่ีมีประโยชน์มากมาย แต่ก็มีแนวทางและความเขา้ใจผิดจ านวนมากท่ีจะน าไปสู่การ
สร้างชุดสีท่ีให้ความรู้สึกไม่เหมาะสม ในบางสถานการณ์อาจใชสี้เป็นเพียงเคร่ืองประดบัอยา่งหน่ึง
ในการออกแบบ แต่ในทางตรงกนัขา้ม การใชสี้ท่ีมากเกินไป อาจท าให้ไปบดบงัองคป์ระกอบอ่ืนๆ 
ในหนา้เวบ็เพจได ้ดงันั้นการเลือกใช้สีให้เหมาะสมและเกิดประโยชน์จึงเป็นเร่ืองส าคญั แมว้า่การ
เลือกชุดของสีมาใช้ในเวบ็เพจค่อนขา้งจะข้ึนอยูก่บัความชอบของแต่ละคน อย่างน้อยเราควรมีคว
เขา้ใจถึงหลกัการใชสี้เบ้ืองตน้ ท่ีจะช่วยในการเลือกใชสี้ชุดใดชุดหน่ึงจากชุดสีพื้นฐานอ่ืนๆไดอ้ยา่ง
เหมาะสมกบัลกัษณะของเวบ็ไซต ์อยา่งไรก็ตามทฤษฎีเหล่าน้ีจะไม่ท าให้คุณสามารถเลือกชุดสีได้
ในทนัทีทนัใด แต่อยา่งนอ้ยก็จะช่วยน าคุณไปในทิศทางท่ีถูกตอ้งได ้
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การผสมสี (Color Mixing) 

 รูปแบบการผสมสีเพื่อให้เกิดเป็นสีต่างๆ สามารถแบ่งไดเ้ป็น 2 แบบ คือการผสมของแสง
หรือการผสมแบบบวก ( additive mixing ) และการผสมขององค์วตัถุ (pigment) หรือการผสมแบบ
ลบ (subtractive mixing) ซ่ึงมีรายละเอียดดงัต่อไปน้ี 

1.การผสมสีแบบบวก (Additive Mixing) 

 การผสมสีแบบบวกน้ี เป็นส่ิงท่ีค่อนขา้งยากในการท าความเขา้ใจ เพราะมีหลกัการท่ีลบลา้ง
ส่ิงท่ีคุณถูกสอนมาในสมยัก่อน เราก าลงัจะพูดถึงรูปแบบการผสมของแสง ไม่ใช่การผสมของวตัถุมี
สีบนกระดาษ เน่ืองจากแสงสีขาวประกอบดว้ยล าแสงท่ีมีสีต่างๆตามความยาวคล่ืนแสง ความยาว
คล่ืนแสงพื้นฐานไดแ้ก่สีแดง เขียว และน ้าเงิน ไม่ใช่สีแดง เหลืองและน ้าเงินอยา่งท่ีเราเขา้ใจมาก่อน 
เม่ือคล่ืนแสงเหล่าน้ีมีการซ้อนทบักนัก็จะก่อให้เกิดการบวกและรวมตวักนัของความยาวคล่ืนแสง 
จึงเป็นท่ีมาของช่ือ “สีแบบบวก” เม่ือแสงทั้งสามสีมีการผสมกนัเป็นคู่ ก็จะเกิดเป็นสีน ้าเงินแกมเขียว
หรือ cyan (เกิดจากสีน ้ าเงินบวกกบัเขียว) สีแดงแกมม่วงหรือ magenta (เกิดจากสีแดงบวกกบัน ้ า
เงิน) และสีเหลือง (เกิดจากสีแดงบวกกบัเขียว) และในท่ีสุดเม่ือผสมสีทั้งสามเขา้ด้วยกนั ก็จะได้
ผลลพัธ์เป็นแสงสีขาวอีกคร้ัง  

ส่ือใด ๆ  ก็ตามท่ีมีการใชแ้สงส่องออกมา อยา่งเช่น จอโปรเจคเตอร์ (movie projector) ทีว ี
หรือจอมอนิเตอร์ส าหรับคอมพิวเตอร์ ต่างก็เป็นไปตามกฎของการผสมสีแบบบวกน้ี เพราะเหตุน้ี 
การออกแบบสีส าหรับเวบ็ไซต ์จึงตอ้งอาศยัหลกัการผสมสีแบบบวกน้ีเช่นกนั 

 

 

 

 

 

รูปที ่2.2 รูปแสดงการผสมสีแบบบวก 
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2. การผสมสีแบบลบ (Subtractive Color Mixing) 

 การผสมสีแบบลบไม่ไดมี้ความเก่ียวขอ้งกบัเร่ืองของล าแสงแต่อยา่งใด ๆ  แต่เก่ียวเน่ืองกบั
การดูดกลืนและสะทอ้นแสงของวตัถุต่างๆ เม่ือแสงสีขาวส่องมายงัวตัถุหน่ึงๆวตัถุนั้น จะดูดกลืน
แสงท่ีความยาวคล่ืนบางระดบัไวแ้ละสะทอ้นแสงท่ีเหลือออกมาให้เราเห็น สีขั้นตน้ในรูปแบบน้ี
ประกอบด้วย สีแดงแกมม่วง(magenta)  สีน ้ าเงินแกมเขียว (cyan) และสีเหลือง ซ่ึงไม่ใช่สีแดง 
เหลือง และน ้าเงินอยา่งธรรมดาอยา่งท่ีหลายๆคนเขา้ใจ เม่ือมีการผสมขององคว์ตัถุหรือวตัถุมีสี        

จะเกิดการรวมกนัของสีท่ีจะถูกดูดกลืนไว ้ท าให้ปริมาณแสงท่ีจะสะทอ้นออกมาลดลง จึงเป็นท่ีมา
ของช่ือ “ สีแบบลบ ” เม่ือสีทั้งสามมีการผสมกนัเป็นคู่ๆ ก็จะเกิดผลเป็นสีต่างๆ ไดแ้ก่สีแดง (เกิด
จากสีแดงแกมม่วงบวกกบัเหลือง) สีเขียว (เกิดจากสีเหลืองบวกกบัน ้ าเงินแกมเขียว) และสีน ้ าเงิน 
(เกิดจากสีน ้าเงินแกมเขียวบวกกบัแดงแกมม่วง) ในขั้นสุดทา้ย เม่ือรวมสีทั้งสามเขา้ดว้ยกนัก็จะเห็น
เป็นสีด า เพราะมีการดูดกลืนแสงทุกสีไวท้ั้งหมด ท าใหไ้ม่มีแสงสีใดสามารถสะทอ้นออกมาได ้

 ส่ือต่างๆท่ีเก่ียวขอ้งกบัการใชว้ตัถุมีสี อยา่งเช่น สีท่ีใชใ้นการวาดรูปของศิลปิน , ดินสอสี , 
สีเทียน รวมถึงระบบการพิมพแ์บบ 4 สี ในส่ิงพิมพต่์าง ๆ  (โดยมีหมึกสีด าเพิ่มมาอีกสีหน่ึง)  ลว้น
อาศยัการผสมสีแบบลบน้ีทั้งส้ิน 

 

 

 

 

 

 

รูปที ่2.3 รูปแสดงการผสมสีแบบลบ 

วงล้อสี (Color Wheel) 

เพื่อความเขา้ใจถึงความสัมพนัธ์ของสีท่ีดีข้ึนเราความท าความรู้จกักบัระบบสีท่ีเขา้ใจง่าย 
และมีประโยชน์มากท่ีสุดท่ีเรียกกนัว่า วงล้อสี ( color wheel ) ซ่ึงเป็นรูปแบบหน่ึงท่ีมีระบบการ
จดัเรียงสีทั้งหมดไวใ้นวงกลม วงลอ้สีถูกพฒันาข้ึนจากความตอ้งการกฎระเบียบท่ีชดัเจนของล าดบั
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และความกลมกลืนของสี แมใ้นอดีตจะมีการพฒันาและออกแบบระบบสีในรูปแบบต่าง ๆ มากมาย 
แต่ส่วนใหญ่มกัจะมีความซับซ้อนเกินกวา่ท่ีจะน ามาใช้ประโยชน์ในการออกแบบจริง ในท่ีสุดเรา
จะใช้วงล้อสีแบบ 12 ขั้น ซ่ึงถูกประดิษฐ์ข้ึนโดย Sir Isaac Newtonในปี 1666 ท่ีได้แสดงถึงการ
จดัล าดับเฉดสีอย่างมีเหตุผลและง่ายต่อการน าไปใช้ จึงเป็นประโยชน์อย่างมากต่อศิลปินใน
การศึกษาและออกแบบศิลปะต่าง ๆ รวมทั้งการเลือกใช้สีในกระบวนการออกแบบเวบ็ไซต์ท่ีเรา
ก าลงัสนใจอยู ่

วงล้อสีแบบลบ (Subtractive Color Wheel) 
สีขั้นต้นในวงล้อสีแบบลบประกอบด้วย สีแดงแกมม่วง (magenta) สีน ้ าเงินแกมเขียว 

(cyan) และสีเหลือง ( yellow ) ส่วนสีอ่ืน ๆอาศยัหลกัการผสมสีแบบลบไดเ้ป็นสีท่ีเหลือทั้งหมด 
วงล้อสีแบบบวก (Additive Color Wheel)   

วงลอ้สีแบบบวกน้ีดูคล้ายๆกบัวงล้อสีแบบลบ แต่มีความสมดุลของสีท่ีต่างกนัอย่างมาก 
ตรงท่ีสีโดยส่วนใหญ่ถูกครอบคลุมด้วยสีน ้ าเงินและเขียว ขณะท่ีสีเหลืองและสีแดงมีผลเพียง
เล็กนอ้ยในวงลอ้สีแบบน้ี เช่นเดียวกบัการกระจายตวัของสีในสเป็กตั้ม ซ่ึงมีลกัษณะเด่นของความ
ยาวคล่ืนแสงสีน ้าเงิน และมีส่วนของความยาวคล่ืนแสงสีแดงเพียงเล็กนอ้ย 
สีทีเ่ป็นกลาง (Neutral Colors) 

 สีท่ีเป็นกลางคือสีกลุ่มหน่ึงท่ีไม่ไดถู้กบรรจุไวใ้นวงลอ้สี เพราะเป็นสีท่ีไม่ไดรั้บอิทธิพลใด 
ๆมาจากสีอ่ืน ซ่ึงก็คือสีเทา แมว้่าจะมีเฉดสีของสีเทาจ านวนมากมายไม่ส้ินสุด แต่แค่เพียงท่ี 256 
ระดบั สายตาคนเราก็ไม่สามารถแยกความแตกต่างออกจากกนัไดแ้ล้ว ท าให้มองเห็นเป็นแถบสี
ระหว่างด ากับขาว โดยไม่มีรอยต่อแต่อย่างใด สีเทาได้ช่ือว่าเป็นสีกลางก็เพราะเป็นสีท่ีไม่มี
ลกัษณะเฉพาะส่วนตวั ท าให้ชุดของสีท่ีประกอบไปด้วยสีเทาทั้งหมดจะดูค่อนขา้งจืดชืด ไม่เร้า
อารมณ์ อยา่งไรก็ตาม สีเทาก็จะไปรับเอาลกัษณะจากสีท่ีอยูล่อ้มรอบนั้นเอง เป็นเหตุให้ศิลปินส่วน
ใหญ่หลีกเล่ียงการใชสี้เทา เพราะผลท่ีไดรั้บจากสีอ่ืนนั้นไม่คงท่ี ยากต่อการควบคุม 

สีเทา 12 ขั้นตามล าดบัจากอ่อนไปเขม้ 

สีอ่อน สีเข้ม และโทนสี (Tint ,Shade and Tone) 

ในการผสมสีกลางดงักล่าวเขา้กบัสีบริสุทธ์ิ (สีท่ีไม่ผ่านการผสมกบัสีอ่ืนมาก่อน) จะเกิด
เป็นสีต่างๆจ านวนมากมาย จนไม่สามารถบรรจุไวใ้นวงลอ้สีไดท้ั้งหมด จากประสบการณ์ท่ีผา่นมา 
คุณคงรู้วา่สีแดงไม่ไดมี้เพียงเฉดสีเดียว แทจ้ริงแลว้ มีแดงอ่อน,แดงแก่,แดงเขม้ หรืองแดงจาง ฯลฯ 
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อีกจ านวนนบัไม่ถว้น สีเหล่าน้ีเป็นผลมาจากการผสมของสีบริสุทธ์ิกบัสีด า ขาว และเทาระดบัต่างๆ 
นัน่เอง 

-เม่ือสีบริสุทธ์ิผสมกบัสีขาว จะไดเ้ป็นสีอ่อน ( tint of the hue ) 
-เม่ือสีบริสุทธ์ิผสมกบัสีเทา จะไดเ้ป็นโทนสีท่ีระดบัต่างๆ ( tone of the hue ) 
-เม่ือสีบริสุทธ์ิผสมกบัสีด า จะไดเ้ป็นสีเขม้ ( shade of the hue ) 
สีอ่อน สีเข้ม และโทนสี มีประโยชน์อย่างมาก ในการจดัชุดของสี เพราะท าให้สีสีหน่ึง

สามารถแสดงออกและให้ความรู้สึกได้หลายรูปแบบยิ่งข้ึน ทดแทนการใช้สีเดียวลว้นๆ ซ่ึงอาจมี
ลกัษณะไม่น่าสนใจ 

 

รูปที ่2.4 รูปแสดงความหลากหลายของสีท่ีไดจ้ากการผสมสีหลกักบัสีขาว เทา และด า 

ความกลมกลืนของสี ( Color Harmony ) 

 ความกลมกลืนของสี หมายถึงความเป็นระเบียบของสีอยา่งเป็นท่ีน่าพึงพอใจต่อสายตา ท า
ให้ผูช้มรู้สึกถึงความเป็นระเบียบ สมดุล และความสวยงามในเวลาเดียวกนั การใชสี้ท่ีจืดชืดเกินไป
จะท าให้เกิดความรู้สึกน่าเบ่ือ และไม่สามารถดึงดูดความสนใจจากผูช้มได ้ในทางตรงกนัขา้ม การ
ใชสี้ท่ีมากเกินไป ดูวุน่วาย ไร้ระเบียบ ก็จะสร้างความไม่เขา้ใจและสับสนให้ผูช้ม ดงันั้น เป้าหมาย
ส าคญัของเราในเร่ืองสี ก็คือการน าเสนอเว็บไซต์โดยใช้ชุดสีในรูปแบบท่ีเขา้ใจไดง่้าย น่าสนใจ 
และส่ือความหมายไดอ้ยา่งเหมาะสม 

รูปแบบชุดสีพืน้ฐาน ( Simple Color Schemes ) 

 หลังจากคุณได้รู้จกัพื้นฐานของสีมาพอสมควร ต่อไปจะเป็นเร่ืองของชุดสีท่ีถูกจดักลุ่ม
อยา่งเขา้กนัดว้ยรูปแบบต่างๆ ท าให้เรามีโอกาสเลือกชุดสีเหล่าน้ีมาใช้ในการออกแบบไดโ้ดยไม่
ตอ้งเสียเวลาสุ่มเลือกสีต่างๆให้ดูเขา้กนั อยา่งไรก็ตามคุณควรยึดรูปแบบเหล่าน้ีเป็นเพียงหลกัการ
เบ้ืองตน้ และยงัคงตอ้งท าการปรับเปล่ียนค่าของสี ( hue )ความอ่ิมตวัของสี ( saturation ) และความ
สวา่งของสี ( lightness ) เพื่อใหเ้กิดลกัษณะท่ีอ่านง่าย สวยงาม และเหมาะสมกบัเน้ือหาของเวบ็ไซต ์
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ชุดสีแบบสีเดียว (Monochromatic Color Scheme) 

 รูปแบบของชุดสีท่ีง่ายท่ีสุดคือชุดแบบสีเดียวท่ีมีค่าของสีบริสุทธ์ิเพียงสีเดียว ความหาก
หวายของสีชุดน้ีเกิดจากการเพิ่มสีเดียว ความหลากหลายของสีชุดน้ีเกิดจากการเพิ่มความเขม้หรือ
ความเข้มหรือความอ่อนในระดับต่างๆ ให้กับสีตั้ งต้น ดังนั้ น ชุดสีแบบเดียวของสีแดงอาจ
ประกอบดว้ยสีแดงลว้น สีแดงอิฐ(สีเขม้ ของสีแดง) สีสตอเบอร์ร่ี(สีอ่อนปานกลางของสีแดง) ละ
ชมพู(สีอ่อนมากของสีชมพู) 

 ชุดสีแบบน้ีค่อนขา้งจะมีความกลมกลืนเป็นหน่ึงเดียวกนั และประสิทธิภาพในการสร้าง
อารมณ์โดยรวมด้วยการใช้สีเพียงสีเดียว แต่ในบางคร้ังรูปแบบท่ีมีสีเดียวน้ีอาจดูไม่มีชีวิตชีวา 
เพราะขาดความหลากหลายของสี ซ่ึงอาจท าใหผู้อ่้านความสนใจ 

 

 

 

 

 

 

 

 

รูปที ่2.5  รูปแสดงชุดสีแบบเดียว 
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ชุดสีแบบสามเส้า (Triadic Color Scheme) 

 วิธีการท่ีงายอีกแบบหน่ึงในการเลือกชุดสีมาใช้ก็คือ การนึกถึงสามเหล่ียมดา้นเท่าลอยอยู่
เหนือวงลอ้สี เพียงเท่าน้ี สีท่ีอยูท่ี่มุมของสามเหล่ียมทั้งสามก็จะเป็นสีท่ีเขา้ชุดกนั ชุดสีท่ีไดจ้ากการ
เลือกแบบน้ีจึงเรียกวา่ ชุดสีแบบสามเส้า ซ่ึงอาจประกอบดว้ยสีสามสีท่ีมีระยะห่างกนัเท่ากนัในวง
ลอ้สี จึงมีความเขา้กนัอยา่งลงตวั ชุดสีแบบสามเส้าท่ีมีประสิทธิภาพมากท่ีสุดคือ ชุดท่ีประกอบดว้ย
สีขั้นตน้ทั้งสามนั้นเอง เน่ืองจากการตดักนัอย่างรุนแรงของสีทั้งสามนั่นเอง เน่ืองจากการตดักนั
อยา่งรุนแรงของสีทั้งสาม ท่ีสร้างความสะดุดตาอย่างมาก ส่วนชุดสีท่ีไดจ้ากสีชั้นสองและสีขั้นท่ี
สามนั้น ยากต่อการน ามาใชเ้พราะความแตกต่างของสีดงักล่าวยงัไม่รุนแรงนกั 

 ชุดสีแบบสามเส้ามีขอ้ได้เปรียบตรงท่ีมีเสถียรภาพสูง เพราะแต่ละสีมีความสมดุลอย่าง
สมบูรณ์แบบกบัอีกสองสีท่ีเหลือ และรูปแบบน้ียงัมีลกัษณะของความเคล่ือนไหว เน่ืองจากแต่ละสี
มีการชกัน าไปสู่กนัและกนั ตามกระบวนการธรรมชาติ ท าให้มีลกัษณะเด่นในดา้นความมีชีวิตชีวา 
ซ่ึงเป็นประโยชน์ในการน าเสนอขอ้มูลในรูปแบบท่ีชดัเจน แน่นอน แต่บางคร้ังความสดใสดงักล่าว
อาจมีลกัษณะท่ีฉูดฉาดเกินไปจนไปรบกวนการส่ือสารความหมายท่ีแทจ้ริงได ้

 

 

 

 

รูปที ่2.6  รูปแสดงชุดสีแบบสามเส้า 
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ชุดสีทีค่ล้ายคลงึกนั (Analogous Color Scheme) 

 ชุดสีท่ีมีรูปแบบอยา่งง่ายอีกแบบหน่ึง ก็คือชุดสีท่ีคลา้ยคลึงกนั ซ่ึงจะประกอบดว้ยสี 2 หรือ 
3 สีท่ีอยู่ติดกนัในวงล้อสี เช่นสีแดงแกมม่วง สีแดง และสีส้ม เน่ืองจากชุดสีท่ีอยู่ในรูปแบบน้ีมี
จ านวนมากมายท าให้เราสามารถเลือกชุดสีแบบน้ีมาใช้งานได้อย่างง่ายสะดวก และแม้ว่าเรา
สามารถเพิ่มจ านวนสีในชุดให้มากข้ึนเป็น 4  หรือ 5 สีได ้แต่กลบัจะมีผลให้ขอบเขตของสีท่ีมีความ
กวา้งเกินไป ท าให้สีอยูต่รงปลายทั้งสองของชุดไม่มีความสัมพนัธ์กนั เป็นสาเหตุให้ลกัษณะการท่ี
อยูต่รงปลายทั้งสองชุดไม่มีความสัมพนัธ์ เป็นสาเหตุใหล้กัษณะการท่ีมีสีคลา้ยคลึงกนัลดลง 

 ณ บางต าแหน่งของวงลอ้สี ชุดสีคลา้ยคลึงกนั 3-4 สีทีอยูติ่ดกนัอาจดูเหมือนเป็นสีเดียวกนั  
เพราะมีสีใดสีหน่ึงคลุมโทนของสีทั้งหมดไว ้ ไม่เพียงแต่ชุดสีแบบน้ีจะน ามาใช้งานได้สะดวก  
ความคลา้ยคลึงกนัของสียงัก่อใหเ้กิดความกลมกลืนกนัอีกดว้ย  แมก้ระนั้นก็ดีการขาดความแตกต่าง
อยา่งชดัเจน  อาจท าใหไ้ม่มีความเด่นเพียงพอท่ีจะดึงดูดความสนใจของผูอ่้านได ้

 

 

 

 

 

 

รูปที ่2.7  รูปแสดงชุดสีท่ีคลา้ยคลึงกนัประกอบดว้ยสี 2-3 สีทีอยูติ่ดกนัในวงลอ้สี 

ชุดสีตรงข้าม (Complementary Color Scheme) 

 สีตรงขา้มในท่ีน้ี  หมายถึง  สีท่ีอยู่ตรงกนัขา้มกนัในวงลอ้สี  เช่น  สีแดงกบัฟ้า  หรือสีน ้ า
เงินอ่อนกบัส้มน่าสนใจท่ีว่าเม่ือน าสีทั้งสองน้ีมาผสมกนั  จะได้ผลลพัธ์เป็นสีขาวส าหรับวงลอ้สี
แบบบวก  หรือไดเ้ป็นสีด าส าหรับวงลอ้สีแบบลบ  ท่ีเป็นเช่นน้ีก็เน่ืองจากวา่สีแต่ละสีท่ีอยูต่รงขา้ม
กนั  จะมีอตัราส่วนของสีขั้นตน้ท่ีผกผนักนั  ตวัอย่างเช่น  สีแดงในวงลอ้สีแบบบวกมีสีท่ีตรงขา้ม
เป็นสีน ้ าเงินแกมเขียว  ซ่ึงเป็นส่วนผสมจากสีน ้าเงินและเขียว  จึงท าให้สีทั้งสองรวมกนัยงัไดเ้ป็นสี
ขาวอีกเช่นเดิม  จากคุณสมบติัน้ีเราอาจเรียกสีคู่น้ีวา่เป็น “สีเติมเตม็”  ก็ได ้
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 เม่ือน าสีทั้งสองมาใชคู้่กนัก็จะท าให้สีทั้งสองมีความสวา่ง  และสดใสมากข้ึน  ซ่ึงถือเป็นคู่
สีท่ีมีความแตกต่างมากท่ีสุด  และยงัมีความเสถียรมากท่ีสุด (maximum contrast and maximum 
stability)  ขอ้ไดเ้ปรียบของสีในรูปแบบน้ีคือ  ความสดใส  สะดุดตา  และบางคร้ังดูน่าสนใจกวา่สีท่ี
ใช้รูปแบบสามจุดเสียอีก  ท าให้แน่ใจไดว้่าชุดสีตรงกนัขา้มน้ี  จะไม่ดูจืดชืด  ขาดความน่าสนใจ  
อย่างไรก็ดีจ  านวนสีท่ีจ ากดัในรูปแบบน้ี  ท าให้ผูอ่้านให้ความสนใจไดง่้าย  แลว้หลงัจากนั้นก็อาจ
ละทิ้งความรู้สึกสนใจไปไดง่้ายเช่นกนั 

 

 

 

 

 

 

รูปที ่2.8  รูปแสดงชุดสีตรงขา้มไดแ้ก่สี 2 สีท่ีอยูต่รงขา้มในวงลอ้ 

 

ชุดสีตรงข้ามข้างเคียง (Split Complementary Color Scheme) 

 ชุดสีตรงขา้มขา้งเคียงมีรูปแบบท่ีเปล่ียนแปลงมาจากชุดสีตรงขา้ม  แต่ละความแตกต่างกนั
ท่ีสีใดสีหน่ึงท่ีอยูต่รงขา้มกนัถูกแทนท่ีดว้ยสีท่ีอยูด่า้นขา้งทั้งสอง  เช่น  สีฟ้าซ่ึงมีสีดา้นขา้งเป็นสีน ้ า
เงินอ่อนกบัสีน ้ าเงินแกมเขียว  ฉะนั้นชุดสีตรงขา้มขา้งเคียงท่ีไดจึ้งประกอบดว้ย  สีแดง  สีน ้ าเงิน
อ่อน  และสีน ้าเงินแกมเขียว   

 ขอ้ได้เปรียบของชุดสีแบบน้ี  คือ  ความหลากหลายท่ีมากข้ึนเม่ือเทียบกบัชุดสีตรงขา้ม  
อยา่งไรก็ตามความหลากหลายท่ีเพิ่มข้ึนมาน้ี  มีผลให้ความสดใสและความสะดุดตาลดลง  รวมถึง
ความเขา้กนัของสีก็ลดลงดว้ย 
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รูปที ่2.9 รูปแสดงชุดสีตรงขา้มขา้งเคียง 

ชุดสีตรงข้ามข้างเคียงทั้ง 2 ด้าน (Double Split Complementary Color Scheme) 

 ชุดสีแบบน้ีถูกดดัแปลงมาจากชุดสีตรงขา้ม  เช่นกนั  แต่คราวน้ีสีตรงกนัขา้มทั้งสองถูก
แบ่งแยกเป็นสีด้านขา้งทั้ง 2 ด้าน  จึงได้เป็นชุดสี 4 สี  ดังเช่นสีแดงแกมม่วงกบัน ้ าเงินแกมเขียว  
และน ้ าเงินอ่อนกบัส้ม  ขอ้ไดเ้ปรียบท่ีเห็นไดช้ดั  คือ  ความหลากหลายท่ีเพิ่มข้ึนจากชุดสีตรงขา้ม
แบบแบ่งแยก  ส่วนขอ้เสียเปรียบก็ยงัมีลกัษณะเช่นเดิมท่ีความสดใสและความกลมกลืนของสีลดลง 

 

 

 

รูปที ่2.10  รูปแสดงชุดสีตรงขา้มแบบแบ่งแยก 2 ดา้น 

 นอกเหนือจากน้ี  ยงัมีรูปแบบอ่ืนท่ีเรียกวา่ Alternate Complementary Color Scheme  โดยมี
สีท่ีไดจ้ากสามเหล่ียมรวมกบัอีกสีหน่ึงท่ีอยูต่รงกนัขา้มกบัสีใดสีหน่ึงในสามเหล่ียม  เช่น  สีเขียว  สี
ม่วงแดง  สีแดง  และสีส้ม  ส่วนแบบสุดทา้ยไดแ้ก่  ชุดสีแบบส่ีเหล่ียม (Tetrad Color Scheme)  ท่ี
เกิดจาก 4 สีท่ีอยูต่รงกนัขา้มภายใตรู้ปส่ีเหล่ียม  วธีิน้ีเป็นการใชสี้ขั้นตน้ 1 สี  สีขั้นท่ีสอง 1 สี  และสี
ขั้นท่ีสาม 2 สี  มาประกอบกนั 
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ทฤษฎสีีกบัการออกแบบเวบ็ไซต์ 

 

รูปที ่2.11 ทฤษฎีสี 

 การสร้างสีสันบนหนา้เวบ็เป็นส่ิงท่ีส่ือความหมายของเวบ็ไซตไ์ดอ้ยา่งชดัเจน การเลือกใช้
สีให้เหมาะสม กลมกลืน ไม่เพียงแต่จะสร้างความพึงพอใจให้กบัผูใ้ช้ แต่ยงัสามารถท าให้เห็นถึง
ความแตกต่างระหวา่งเวบ็ไซตไ์ด ้สีเป็นองคป์ระกอบหลกัส าหรับการตกแต่งเวบ็ จึงจ าเป็นอยา่งยิ่ง
ท่ีจะตอ้งท าความเขา้ใจเก่ียวกบัการใชสี้ระบบสีท่ีแสดงบนจอคอมพิวเตอร์ มีระบบการแสดงผลผา่น
หลอดล าแสงท่ีเรียกวา่ CRT (Cathode ray tube) โดยมีลกัษณะระบบสีแบบบวก อาศยัการผสมของ
ของแสงสีแดง สีเขียว และสีน ้ าเงิน หรือระบบสี RGB สามารถก าหนดค่าสีจาก 0ถึง 255 ได้ จาก
การรวมสีของแม่สีหลักจะท าให้เกิดแสงสีขาว มีลักษณะเป็นจุดเล็ก ๆ บนหน้าจอไม่สามารถ
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มองเห็นดว้ยตาเปล่าได ้จะมองเห็นเป็นสีท่ีถูกผสมเป็นเน้ือสีเดียวกนัแลว้ จุดแต่ละจุดหรือพิกเซล 
(Pixel) เป็นส่วนประกอบของภาพบนหน้าจอคอมพิวเตอร์ โดยจ านวนบิตท่ีใช้ในการก าหนด
ความสามารถของการแสดงสีต่าง ๆ เพื่อสร้างภาพบนจอนั้นเรียกว่า บิตเด็ป (Bit-depth) ในภาษา 
HTML มีการก าหนดสีด้วยระบบเลขฐานสิบหก ซ่ึงมีเคร่ืองหมาย (#) อยู่ด้านหน้าและตามด้วย
เลขฐานสิบหกจ านวนอกัษรอีก 6 หลกั โดยแต่ละไบต ์(byte) จะมีตวัอกัษรสองตวั แบ่งออกเป็น 3 
กลุ่ม เช่น #FF12AC การใชต้วัอกัษรแต่ละไบตน้ี์เพื่อก าหนดระดบัความเขม้ของแม่สีแต่ละสีของชุด
สี RGB โดย 2 หลกัแรก แสดงถึงความเขม้ของสีแดง 2 หลกัต่อมา แสดงถึงความเขม้ของสีเขียว 2 
หลกัสุดท้ายแสดงถึงความเขม้ของสีน ้ าเงิน  สีมีอิทธิพลในเร่ืองของอารมณ์การส่ือความหมายท่ี
เด่นชดั กระตุน้การรับรู้ทางดา้นจิตใจมนุษย ์สีแต่ละสีให้ความรู้สึก อารมณ์ท่ีไม่เหมือนกนั สีบางสี
ให้ความรู้สึกสงบ บางสีให้ความรู้สึกต่ืนเตน้รุนแรง สีจึงเป็นปัจจยัส าคญัอยา่งยิ่งต่อการออกแบบ
เว็บไซต์ ดงันัน้การเลือกใช้โทนสีภายในเว็บไซต์เป็นการแสดงถึงความแตกต่างของสีที่แสดงออกทางอารมณ์ มี
ชีวิตชีวาหรือเศร้าโศก รูปแบบของสทีี่สายตาของมนษุย์มองเห็น สามารถแบง่ออกเป็น 3 กลุม่ คือ 

1. สีโทนร้อน (Warm Colors) เป็นกลุ่มสีท่ีแสดงถึงความสุข ความปลอบโยน ความ

อบอุ่น  

รูปที ่2.12  รูปแสดงชุดสีร้อน 

 

 

รูปที ่2.13  รูปแสดงชุดสีเยน็ 

 

 2. สีโทนเยน็ (Cool Colors) แสดงถึงความท่ีดูสุภาพ อ่อนโยน เรียบร้อย เป็นกลุ่มสีท่ีมีคนชอบ
มากท่ีสุด สามารถโนม้นาวในระยะไกลได ้ 

 3. สีโทนกลาง (Neutral Colors) สีท่ีเป็นกลาง ประกอบด้วย สีด า สีขาว สีเทา และสีน ้ าตาล
กลุ่มสีเหล่าน้ีคือ สีกลางท่ีสามารถน าไปผสมกับสีอ่ืน ๆ เพื่อให้เกิดสีกลางข้ึนมาส่ิงท่ีส าคญัต่อ
ผูอ้อกแบบเวบ็คือการเลือกใช้สีส าหรับเวบ็ นอกจากจะมีผลต่อการแสดงออกของเวบ็แลว้ยงัเป็น
การสร้างความรู้สึกท่ีดีต่อผูใ้ช้บริการ ดงันั้นจะเห็นว่าสีแต่ละสีสามารถส่ือความหมายของเวบ็ได้
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อยา่งชดัเจน ความแตกต่าง ความสัมพนัธ์ท่ีเกิดข้ึนยอ่มส่งผลใหเ้วบ็มีความน่าเช่ือถือมากยิ่งข้ึน ชุดสี
แต่ละชุดมีความส าคญัต่อเวบ็ ถา้เลือกใชสี้ไม่ตรงกบัวตัถุประสงคห์รือเป้าหมายอาจจะท าใหเ้วบ็ไม่
น่าสนใจ ผูใ้ช้บริการจะไม่กลับมาใช้บริการอีกภายหลัง ฉะนั้นการใช้สีอย่างเหมาะสมเพื่อส่ือ
ความหมายของเวบ็ตอ้งเลือกใชสี้ท่ีมีความกลมกลืนกนั 

ข้อคิดเกีย่วกบัการใช้สีในเวบ็ไซต์ 

จากสีท่ีไดเ้รียนรู้มาตัง่แต่ตน้เก่ียวกบัสีและส่ือต่าง ๆ ท่ีมีผลต่อการสแดงออกของสี คงจะ
พอท าใหคุ้ณออกแบบเวบ็ไซตโ์ดยใชสี้ท่ีเหมาะสมกลมกลืนกนัในการส่ือความหมายถึงเน้ือหา และ
สร้างความสวยงานให้กบัหน้าเวบ็เพจไดเ้ป็นอยา่งดี และท่ีส าคญัจาการใชชุ้ดสีส าหรับเวบ็เพจท่ีมี
สีสันตรงกบัความตั้งใจอยา่งไม่ผิดเพี้ยนในส่วนน้ี เป็นเร่ืองของขอ้คิดสั้น ๆ เก่ียวกบัการใชสี้ให้เกิด
ประโยชน์กบัเวบ็ไซต ์3 ขอ้ดงัน้ี 

1. ใช้สีอย่าสม ่าเสมอ 
การออกแบบเวบ็ไซต์โดยใช้สีอย่างสม ่าเสมอช่วยสร้างความรู้สึกถึงบริเวณของสถานท่ี 

เช่นการใช้สีท่ีเป็นชุดเดียวกนัตลอดทั้งไซต์เพื่อสร้างขอบเขตของเวบ็ไซต์ท่ีสัมผสัไดด้ว้ยตา เม่ือ
ผูใ้ชค้ลิกเขา้ไปในแต่ละหนา้ก็ยงัรู้สึกไดว้า่ก าลงัอยูภ่ายในเวบ็ไซตเ์ดียวกนั 

2. ใช้สีอย่างเหมาะสม 
เวบ็ไซต์เปรียบเสมอสถานท่ีหน่ึงๆ ท่ีมีลกัษณะเฉพาะ เช่นเดียวกบัสถานท่ีต่าง ๆ ในชีวิต

จริงอย่าง ธนาคาร โรงเรียน หรือร้านค้าต่าง ๆ ดงันั้น การเลือกใช้สีท่ีเหมาะสมกบัลักษณะของ
เวบ็ไซต์ จะช่วยส่งเสริมเป้าหมายและภาพพจน์ของเวบ็ไซต์ได้ นอกจากน้ีคุณควรค านึงถึงปัจจยั
หลายๆอยา่งท่ีมีผลต่อความเหมาะสมของสีในเวบ็ไซต์ เช่น วฒันธรรม แนวโน้ม ของแฟชัน่ อายุ
และประสบการณ์ของผูใ้ช้ ดงันั้นเราจึงรู้สึกเห็นด้วยเม่ือมีการใช้สีชมพูเพื่อสแดงถึงความรัก ใช้
โทนสีน ้ าตาลด า ส่ือถึงเหตุการณ์ใน อดีต ใช้สีสดใสสาหรับเด็ก และการใช้สีตามแฟชั่นในเวบ็มี
เก่ียวกบัเคร่ืองแต่งกาย 

 3. ใช้สีเพ่ือส่ือความหมาย 

Color Wheel Pad ท่ีออกแบบโดย web.designBrand.com มีการแสดงค่าของสีในระบบ
เลขฐานสิบไวใ้นแต่ละช่องสี ซ่ึงจะเป็นประโยชน์ในการเลือกใช้สีตามรูปแบบต่าง ๆ จากวงลอ้สี
ดงัท่ีไดเ้ห็นแลว้วา่ สีแต่ละสีให้ความหายและความรู้สึกต่างกนั โดยสีหน่ึงๆ อาจส่ือความหายไปใน
ทางบวกหรือทางลบก็ได ้ข้ึนอยู่กบัสถานการณ์ ตวัอยา่งเช่น สีด าให้ความรู้สึกโศกเศร้าในงานศพ 
แต่กลบัสีแดงถึงความเป็นมืออาชีพในการแสดงผลงานของศิลปิน ดงันั้นสีท่ีให้ความหมายและ
ความรู้สึกตรงกบัเน้ือหา จะช่วยสนบัสนุนใหผู้ใ้ชไ้ดรั้บขอ้มูลท่ีถูกตอ้งและครบถว้น 
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4. ระบบสีในเวบ็ไซต์ 
ระบบสีในเวบ็ไซต์มีรูปแบบเฉพาะตวัท่ีแตกต่างจากสีอ่ืน ๆ อย่างส้ินเชิง ท าให้การใช้สี

อย่างมีประสิทธิภาพในเวบ็จึงตอ้งอาศยัความเขา้ใจรายละเอียดทางเทคนิคพอสมควร ระบบสีท่ีมี
ความเฉพาะตวัน้ีเป็นผลมาจากความเก่ียวขอ้งกบัส่ือ 3 ประเภทท่ีมีอิทธิพลต่อการปรากฏของสี ได ้
แก่  

-จอมอนิเตอร์ : เป็นเพราะเวบ็เพจถูกเรียกดูผา่นทางจอมอนิเตอร์ ดงันั้นการแสดงสีของเวบ็
เพจจึงข้ึนอยูก่บัประสิทธิภาพดา้นสีของจอมอนิเตอร์ 

- บราวเซอร์ : เน่ืองจากบราวเซอร์มีระบบการความคุมและแสดงสีภายในตวัเอง เม่ือใดท่ีมี
การแสดงผลในหน้าจอท่ีมีจานวนสีจากดั บราวเซอร์จะท าการสร้างสีทดแทนให้ดูเหมือนหรือ
ใกลเ้คียงกบัสีท่ีก าหนดไว ้ผลลพัธ์ท่ีไดจึ้งไม่แน่นอน 

- HTML : สีในเวบ็เพจท่ีไม่ไดเ้ป็นส่วนหน่ึงของรูปภาพ เช่น สีของตวัอกัษรและพื้นหลงั 
จะถูกควบคุมด้วยค าสั่งภาษา HTML โดยระบุค่าของสีในระบบเลขฐานสิบหกเพราะฉะนั้น การ
เขา้ใจถึงอิทธิพลของปัจจยัทั้งสาม และออกแบบโดยค านึงถึงขอ้จ ากดัเหล่าน้ี จะท าให้ผูใ้ชโ้ดยส่วน
ใหญ่ไดเ้ห็นสีท่ีถูกตอ้งอยา่งท่ีคุณตั้งใจ 
หลกัส าคัญในการออกแบบหน้าเวบ็ไซต์อย่างหน่ึงคือ 

1. การสร้างล าดบัชั้นความส าคญัขององคป์ระกอบต่าง ๆ ภายในหนา้เวบ็เพื่อเนน้ให้เห็นวา่
อะไรเป็นเร่ืองส าคัญมาก ส าคัญรองลงไปหรือส าคัญน้อยตามล าดับการจัดระเบียบของ
องคป์ระกอบอยา่งเหมาะสมจะช่วยให้แสดงถึงความสัมพนัธ์ระหวา่งองค์ประกอบต่าง ๆ ในหน้า
เวบ็ไซตใ์นการออกแบบควรใหค้วามส าคญักบัปัจจยัเหล่าน้ี 

1.1 สีและความแตกต่างของสี แสดงถึงความส าคญัของข้อมูลท่ีต้องการให้ผูใ้ช้ได้รับ
เน่ืองจากภาษาส่วนใหญ่รวมถึงภาษาไทยและองักฤษจะอ่านจากซ้ายไปขวาและจากบนลงล่าง จึง
ควรจดัวางส่ิงท่ีมีความส าคญัไวท่ี้ส่วนบนหรือดา้นล่างของหนา้อยูเ่สมอเพื่อให้ผูใ้ชไ้ดเ้ห็นก่อนแต่
ถา้จดัวางส่ิงส าคญัไวท่ี้ส่วนทา้ยของหนา้ ผูใ้ชจ้  านวนมากอาจจะไม่ไดรั้บขอ้มูลนั้น 

1.2 สีและความแตกต่างของสี แสดงถึงความส าคญัและความสัมพนัธ์ของส่ิงต่าง ๆ ภายใน
หนา้ส่ีเด่นชดัเหมาะส าหรับองคป์ระกอบท่ีมีความส าคญัมากส่วนองคป์ระกอบท่ีใชสี้เก่ียวกบัส่ือ  
ประโยชน์ของเวบ็ไซต์ 

1. เป็นการเพิ่มช่องทางในการศึกษาเก่ียวกบัป้ายอีกช่องทางหน่ึง 
2. ไม่ตอ้งเสียค่าใชจ่้ายในการศึกษา 
3. มีหนา้เวบ็ (Homepage) เป็นของตนเอง มีความทนัสมยั 
4. เสริมภาพลกัษณ์ขององคก์รใหมี้ความทนัสมยัน่าเช่ือถือมากข้ึน 
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5. สามารถศึกษาความรู้ผา่นเวบ็ไซตไ์ดต้ลอด 24 ชัว่โมง 
6. เสริมสร้างการศึกษาดว้ยประโยชน์ของ Internet 

โปรแกรม Adobo Dreamweaver CS5 
 เป็นโปรแกรมส าหรับการพฒันาเวบ็ไซต ์โดยมีคุณสมบติัในการออกแบบและสร้างเวบ็เพจ
จนถึงการพฒันาแอพพลิเคชั่นเบ้ืองต้น ซ่ึงในโปรแกรมตวัน้ีมีเคร่ืองมือส ารับการวางข้อความ 
ภาพกราฟิก ตาราง แบบฟอร์ม พร้อมทั้งมลัติมีเดียต่าง ๆ เพื่อแสดงใหผู้พ้ฒันาเวบ็ไซตใ์ชง้านไดง่้าย 
โดยไม่ตอ้งรู้จกัภาษา HTML , JavaScript , CSS หรือภาษาสคริปตอ่ื์นๆ ซ่ึงเม่ือออกแบบและพฒันา
เวบ็ไซต์ในโปรแกรมแลว้น ามาแสดงผลทางบราวเซอร์ก็จะเห็นเป็นลกัษณะท่ีไดจ้ดัวางไว ้หรือจะ
เรียกอีกอย่างว่า What You See Is What You Get (WYSIWYG) จึงเหมาะสมกับผู ้ท่ี เร่ิมต้นและ
ผูใ้ชง้านทัว่ไปจะน ามาพฒันาเวบ็ไซต ์
 

                       
 

รูปที ่2.14 โปรแกรม Adobo Dreamweaver CS5 
 
คุณสมบัติในใหม่ Adobe Dreamweaver CS5 
1. สามารถสร้างเวบ็ไซตไ์ดอ้ยา่งง่าย คือ ช่วยใหข้ั้นตอนของการสร้างเวบ็ไซตท์  าไดง่้ายข้ึน

กวา่เดิม 
2. สามารถตรวจสอบโคด้ CSS อยา่งรวดเร็ว โดยใชว้ธีิการตรวจสอบจากมุมมอง Inspect 

ท าใหส้ามารถตรวจสอบโคด้ CSS ไดแ้ละสามารถแกไ้ขทางพาเนลของ CSS Style ไดท้นัที 
3. ยกเลิกคุณสมบติัของ CSS ไดท้นัทีโดยไม่ตอ้งอ่านโคด้ 
4. สามารถท างานกบั Adobe BrowserLab ซ่ึงเป็นเคร่ืองมืออยูใ่น CS Live ท่ีท าหนา้ท่ี

ใหบ้ริการออนไลน์ Web service โดยสามารถเลือกเวบ็บราวเซอร์ท่ีตอ้งการแสดงผลไดเ้ลย ทั้งยงั
ช่วยในการตรวจสอบความถูกตอ้งและความเขา้กนัไดก้บัเวบ็บราวเซอร์อีกดว้ย 

5. สนบัสนุนการสร้างเวบ็ไซตด์ว้ย HTML 5.0 ซ่ึงจะมีผลต่อการสร้าง SEO ในอนาคตอีก
ดว้ยและยงัมีการปรับปรุงโคด้ต่างๆ ใหค้อมพิวเตอร์สามารถแยกแยะเน้ือหาในเวบ็เพจไดเ้ขา้ใจมาก
ยิง่ข้ึน 
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6. มีตวัช่วยสร้างค าสั่งภาษา PHP จะแสดงในรูปแบบของฟังกช์ัน่ต่างๆ ข้ึนมาใหเ้ลือกใช ้
โดยไม่ตอ้งพิมพค์  าสั่งเอง ซ่ึงจะเป็นผลดีคือไดค้  าสั่งท่ีถูกตอ้งไม่ผดิพลาดในเวลาแสดงผล 

7. สนบัสนุนการท างานร่วมกบั Adobe Business Catalyst ซ่ึงเป็นแอพลิเคชัน่บนเซิร์ฟเวอร์ 
ท าหนา้ท่ีเป็นแพลตฟอร์มกลางของนกัออกแบบเวบ็เพจ ช่วยใหส้ร้างเวบ็เพจออนไลน์ไดดี้ยิง่ข้ึน 

8. รองรับการท างานของ CMS(Content Management System) ซ่ึงจะช่วยในการจดัเน้ือหา
เหมือนการจดัการใน Wordpress Joomla และ Drupal 

        
 คุณสมบัติทีถู่กยกเลกิในเวอร์ช่ันก่อน 
         - การตรวจสอบการท างานของ JavaScript ในบราวเซอร์ 
         - การสร้าง Web Photo Album 
         - การแทรก Navigation bar 
         - การใชง้าน Behavior บางตวั (Show/Hide Pop-up Menu, Show Event For, Play 

Sound.Timeline, Control Shockwave or SWF, Check Browser) 
การเรียกใช้งานโปรแกรม Adobe Dreamweaveer CS5 ขึน้มาใช้งานท าได้ดังนี้ 

วธีิท่ี 1 เรียกผา่น Start โดยการคลิกท่ีปุ่ม Start >>All Program >> Adobe Dreamweaver 
CS5 

 
 

รูปที ่2.15 รูปวธีิท่ี 1 เรียกผา่น Start 
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วธีิที ่2 เรียกผา่นไอคอนบนเดสกท์อปโดยการดบัเบิ้ลคลิกท่ีไอคอน 
 
 

 
 

รูปที ่2.16  รูปวธีิท่ี 2 เรียกผา่นไอคอนบนเดสกท์อปโดยการดบัเบิ้ลคลิกท่ีไอคอน  
 

 

 
 
 

รูปที ่2.17  รูปท่ีคลิกเลือกเปิดโปรแกรมข้ึนมาแลว้จะปรากฏ Welcome Screen ดงัรูป 
 

Welcome Screen เป็นหน้าต่างส าหรับเลือกขั้นตอนการเร่ิมใช้งานโปรแกรม ซ่ึงจะมีตัวเลือก
ออกเป็นกลุ่มๆ คือ 

A : Open a Recent Item เป็นการเปิดไฟล์งานท่ีเคยใช้งานแล้ว โดยจะมีรายช่ือไฟล์งาน
แสดงอยูเ่รียงล าดบัจากท่ีเปิดใชง้านล่าสุดเป็นตน้ไป หรือจะเลือกไฟลอ่ื์นท่ี Open ก็ได ้
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B : Create New เป็นการสร้างไฟล์งานใหม่ โดยปกติแล้วในส่วนน้ีจะเลือกท่ี HTML ซ่ึง
เป็นการสร้างเวบ็เพจพื้นฐาน แต่ถา้เลือกหัวขอ้อ่ืน หนา้เวบ็เพจนั้นก็จะเป็นไฟล์ตามชนิดท่ีเลือกใช้
งาน เช่น ไฟลง์าน PHP, ASP และ JavaScript เป็นตน้ 

C : Top Features (videos) เป็นส่วนท่ีใช้ส าหรับเขา้ไปดูรายละเอียดและเทคนิคต่างๆ ของ
การใชง้านโปรแกรมผา่นทางเวบ็ไซตข์อง Adobe 

        D : เป็นส่วนของการเปิดดูค าแนะน าในการใชง้านโปรแกรม 
        E : เป็นส่วนส าหรับดาวน์โหลดโปรแกรมหรือดูขอ้มูลบนเวบ็ไซตข์อง Adobe 
มุมมองการท างาน  
        เม่ือเปิดเรียกใชง้านโปรแกรมข้ึนมาแลว้จะพบหนา้ต่างการใชง้านดงัรูป (ในท่ีจะเลือก

เป็นแบบ Create new แลว้เลือกเป็นไฟล ์HTML) จะไดห้นา้ต่างเอกสาร(Document) 
 

         
 

รูปที ่2.18 รูป Welcome Screen เป็นหนา้ต่างส าหรับเลือกขั้นตอนการเร่ิมใชง้านโปรแกรม 
 
        หน้าต่างเอกสาร(Document window) คือ ส่วนท่ีใช้ส าหรับใส่เน้ือหาพร้อมทั้งการจดั

องค์ป ระกอบหน้ าเว็บ เพ จ  โดยการใช้ งานนั้ น จะ มีการท างาน เช่น เดี ยวกับ โปรแกรม
เวร์ิดโปรเซสเซอร์ทัว่ไป คือ พิมพข์อ้ความ แทรกรูปภาพ สร้างตาราง เม่ือออกแบบและตกแต่งแลว้
ผลลพัธ์ท่ีแสดงออกมาบนบราวเซอร์ก็จะปรากฏเช่นนั้นดว้ย 

-มุมมองการท างานของหนา้ต่างเอกสารมีอยู ่ 6 มุมมอง ดงัรูป ซ่ึงสามารถคลิกสลบัการ
ท างานไดต้ามตอ้งการ 
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รูปที ่2.19 รูปโคด้ (Code view) 
 

        - มุมมองโคด้ (Code view) เป็นการแสดงมุมมองของเวบ็เพจในรูปแบบของชุดค าสั่งภาษา 

HTML ทั้งเอกสาร ซ่ึงถูกสร้างจากโปรแกรม Dreamweaver อตัโนมติั เหมาะส าหรับเขียนโคด้ค าสั่ง

เพิ่มเติม อาจจะเป็นค าสั่ง JavaScript หรือ CSS ก็ได ้

 

 

 

รูปที ่2.20 รูปออกแบบ (Design view) 

- มุมมองออกแบบ (Design view) เป็นการแสดงมุมมองของเวบ็เพจในลกัษณะของการ

ออกแบบซ่ึงจะปรากฏผลลพัธ์ทางบราวเซอร์ในลกัษณะเดียวกนั 
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รูปที ่2.21 รูปแสดงผลโคน้หนา้เวบ็ (Live Code) 

- มุมมองแสดงผลโคน้หนา้เวบ็ (Live Code) มุมมองน้ีจะแสดงผลร่วมกบัมุมมอง Live 

View โดยจะแสดงมุมมอง Live Code ไดก้็ต่อเม่ืออยูใ่นมุมมอง Livwe View เท่านั้น ซ่ึงจะใช้

ตรวจสอบดูโคด้ในต าแหน่งต่างๆ ไม่สามารถท่ีจะแกไ้ขโคด้ในมุมมองน้ีได ้

           

 

รูปที ่2.22 แสดงหนา้เวบ็เหมือนดูจากบราวเซอร์ (Live View) 
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- มุมมองแสดงหนา้เวบ็เหมือนดูจากบราวเซอร์ (Live View) มุมมองน้ีจะแสดงเวบ็เพจ

เหมือนกบัหนา้ท่ีแสดงผลในบราวเซอร์ สามารถแสดงผลจากค าสั่ง JavaScript และ Plug-in ต่างๆ ท่ี

น ามาใชง้าน 

      

รูปที ่2.23 แสดงผลหนา้เวบ็ท่ีจดัรูปแบบในเวบ็ไซต ์

- มุมมองแสดงผลหนา้เวบ็ท่ีจดัรูปแบบดว้ย CSS (Inspect) มุมมองน้ีจะแสดงผลร่วมกบั 

Live View ซ่ึงเป็นมุมมองท่ีใชใ้นการตรวจสอบการจดัรูปแบบดว้ยค าสั่ง CSS ในต าแหน่งท่ีเมา้ส์

เล่ือนผา่นโดยสามารถดูไดจ้ากพาเนล CSS 

 

รูปที ่2.24 แสดงผลหนา้เวบ็ท่ีจดัรูปแบบดว้ย CSS (Inspect) 



31 

การออกจากโปรแกรม 

เม่ือเปิดใชง้านโปรแกรมเสร็จแลว้ ตอ้งการท่ีจะปิดหรือออกจากโปรแกรม สามารถท าไดห้ลายๆ วธีิ 

ดงัน้ี 

 

 

รูปที ่2.25 รูปคลิกท่ีปุ่ม Close บน Control Box 

 

 

 

รูปที ่2.26 คลิกเลือกท่ีปุ่ม  บนไตเต้ิลบาร์ แลว้ท าการเลือกค าสั่ง Close 
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รูปที ่2.27 รูปคลิกเลือกท่ีเมนู File >> Exit ดงัรูป หรือใชแ้ป้นคียล์ดั Ctrl + Q 
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โปรแกรม Adobo Photoshop 
 โปรแกรม Adobe Photoshop มักเรียกสั้ นๆ ว่าPhotoshop เป็นโปรแกรมประยุกต์ท่ี มี
ความสามารถในการจดัการแกไขและตกแต่งรูปภาพ (photo editing and retouching)แบบแรสเตอร์ 
ซ่ึง Photoshop Cs5 คือรุ่นปัจจุบนั ผลิตโดยบริษทัอะโดบีซิสเต็มส์Photoshop สามารถใช้ในการ
ตกแต่งภาพเล็กน้อย เช่น ลบตาแดง, ลบรอยแตกของภาพ, ปรับแกสี้ ,เพิ่มสีและแสง ไปจนถึงการ
ตกแต่งภาพแบบมืออาชีพ เช่น การใส่เอฟเฟกต์ให้กบัรูป เช่น ท าภาพสีซีเปีย,การท าภาพโมเซค, 
การสร้างภาพพาโนรามาจากภาพหลายภาพต่อกน นอกจากน้ียงัใช้ได้ในการตดัต่อภาพและการ
ซอ้นฉากหลงัเขา้กบัภาพ  Photoshop สามารถท างานกบัระบบสี RGB, CMYK, Lab และ Grayscale 
และสามารถจดัการกบัไฟล์รูปภาพท่ีส าคญัได ้เช่น ไฟล์นามสกุล JPG, GIF, PNG, TIF, TGA โดย
ไฟล์ท่ีโฟโตชอปจดัเก็บในรูปแบบเฉพาะของตวัโปรแกรมเองจะใชน้ามสกุลของไฟล์วา ่่ PSD จะ
สามารถจดัเก็บคุณลกัษณะพิเศษของไฟล์ท่ีเป็ นของโฟโตชอป เช่น เลเยอร์, แชนแนล, โหมดสี 
รวมทั้งสไลดไ์ดค้รบถว้นความตอ้งการของระบบ ก่อนติดตั้ง Photoshop CS5ก่อนท่ีเราจะติดตั้งและ
น าโปรแกรม Photoshop Cs5 มาใชง้าน เราควรจะดูความตอ้งการทางดา้นHardware ของโปรแกรม
ก่อนวา่ถา้ใชเ้คร่ืองในระบบ Windows ตอ้งรุ่นไหน มีหน่วยความจ าเท่าไหร่ หรือพื้นท่ีวางฮาร์ดดิส 
ก่อนทีจ่ะติดตั้งโปรแกรมจ านวนเท่าไหร่ เป็นต้น ซ่ึงจะแบ่งออกเป็น 2 ระบบ ดังนี ้

-ระบบปฏิบติัการ Windows 
 -ความเร็วของซีพีย ู(CPU) ขั้นต ่า 1.8GHz หรือมากกวา่ 
- ระบบปฏิบติัการ Microsoft Windows Xp Service Pack 2 (แนะน าให้ใช้ Service Pack 3) 
หรือ Windows Vista และ Windows 7 
 - หน่วยความจ า (Ram) 1 GB 
 - พื้นท่ีวางในฮาร์ดดิสก์ 1 GB ส าหรับติดตั้งโปรแกรม และควรมีพื้นท่ีวางส าหรับการ
ท างานอีกอยา่งนอ้ย 1 GB 
-ความละเอียดของจอภาพขั้นต ่า 1,024x768 (แนะน าให้ใช้ท่ี 1,280x800) พร้อมการ์ดจอ 
16-bit (Video Card) หากใช ้Photoshop Extended และใชง้านภาพ 3D ควรมีคุณสมบติัของ 
CPU-accelerated ท่ีท างานร่วมกบั Shader Model 3.0 และใชง้านกบ ่ั OpenGL 2.0 
 - ไดรว ์DVD-ROW ส าหรับใส่ DVD ติดตั้งโปรแกรม 
 - โปรแกรม QuickTime 7.2 ข้ึนไป ส าหรับการท างานกบัมลัติมีเดีย เช่น วดีิโอ 
 -การเช่ือมต่ออินเทอร์เน็ต ถ้าจ าเป็นตอ้งเขา้ไปใช้บริการออนไลน์ เช่น Help หรือดาวน์
โหลดปลัก๊อินเป็นตน้ 
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ระบบปฏิบัติการ Mac OS 
 - ซีพีย ูPowerPC G5 หรือ multicore Intel processor 
 - ระบบปฏิบติัการ Mac OS X ตั้งแต่v10.4.11 ข้ึนไป 
 - หน่วยความจ า 1 GB 
 - พื้นท่ีวางในฮาร์ดดิสก์ 2 GB ส าหรับติดตั้งโปรแกรม และควรมีพื้นท่ีวางส าหรับการ
ท างานอยา่งอ่ืนเป็นตน้ 

Photoshop CS5 จะแตกต่างจาก CS3 และ CS4 ไปบา้งเล็กนอ้ยกล่าวคือโดยพื้นฐานจะคงเดิม แต่จะ
ปรับการใช้งานให้ดูง่ายข้ึน มีการเก็บรวบรวมเคร่ืองมือท่ีเก่ียวข้องเอาไวใ้นท่ีเดียวกันเพิ่มชุด
เคร่ืองมือเขา้มาใหม่และยงัลดขั้นตอนการท างานให้นอ้ยลงท าให้ใชง้านสะดวกยิงข้ึน ในเวอร์ชนัน้ี
ไดเ้พิ่มค าสั่ง และแถบเคร่ืองมือท่ีใชบ้่อย ๆ วางแยกออกมาจากกลุ่มเคร่ืองมือเดิม เช่น เคร่ืองมือปรับ
มุมมอง เคร่ืองมือปรับแต่งภาพท่ีรวมอยูใ่นพาเนลเดียวกนั เช่น พาเนล Adjustments ส่วนการท างาน
หลกั ๆ ยงัคงอิงการใช้งานเหมือนเวอร์ชนัท่ีผ่าน ๆ มา ซ่ึงหน้าจอใหม่ของ Photoshop CS5 ก็จะมี
ส่วนประกอบดงัภาพ 
 
ส่วนประกอบของโปรแกรม Photoshop Cs5 
 

 
 

รูปที ่2.27 รูปส่วนประกอบต่างๆ 
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Application Bar (แอพพลิเคชัน่บาร์) จะเป็นแถบเคร่ืองมือท่ีเก็บปุ่มค าสั่งท่ีใช้งานบ่อย ๆ 
เอาไว ้เช่นเปิดโปรแกรม Bridge หมุนพื้นท่ีท างานย่อ-ขยายภาพ, จัดเรียงวินโดว์ภาพ และจัด
องคป์ระกอบของเคร่ืองมือตามพื้นท่ีใชง้าน (Workspace) 

 Menu Bar (เมนูบาร์) ประกอบดว้ยกลุ่มค าสั่งต่าง ๆ ท่ีใชจ้ดัการกบัไฟล์ท างานกบัรูปภาพ
และใชก้ารปรับแต่งการท างานของโปรแกรม โดยแบ่งเมนูตามลกัษณะงาน นอกจากน้ีบางเมนูหลกั 
จะมีเมนูยอยซ่อ้นอย ูโดยสังเกตจากเคร่ืองหมาย ่่ ซ่ึงคุณตอ้งเปิดเขา้ไปเพื่อเลือกค าสั่งภายในอีกที 

Tool Panel (ทูลพาเนล) หรือ กล่องเคร่ืองมือจะประกอบไปด้วยเคร่ืองมือต่าง ๆ ท่ีใช้ใน
การวาดตกแต่ง และแกไขภาพเคร่ืองมือเหล่าน้ีมีจ  านวนมาก ดงันั้นจึงมีการรวมเคร่ืองมือท่ีท าหนา้ท่ี
คลา้ย ๆ กนัไวใ้นปุ่มเดียวกนัโดยจะมีลกัษณะรูปสามเหล่ียมอยูบ่ริเวณมุมดา้นล่างดงัภาพเพื่อบอก
ใหรู้้วาในปุ่มน้ียงัมีเคร่ืองมืออ่ืนอยูด่ว้ย 

Option Bar (ออปชั่นบาร์) เป็นส่วนท่ีใช้ปรับแต่งค่าการท างานของเคร่ืองมือต่าง ๆ โดย
รายละเอียดในออฟชัน่บาร์จะเปล่ียนไปตามเคร่ืองมือท่ีเราเลือกจากทูล ่่ บ็อกซ์ในขณะนั้น เช่น 
เม่ือเราเลือกเคร่ืองมือBrush (พูกนั) บนออปชั่นบาร์จะปรากฏออฟชั่นท่ีใช้ในการก าหนดขนาด 
และลกัษณะหวัแปรงโหมดในการระบายความโปร่งใสของสีและอตัราการไหลของสีเป็นตน้ 

Panel (พาเนล) เป็นวินโดวย์อ่ย ๆ ท่ีใช้เลือกรายละเอียด หรือค าสั่งควบคุมการท างานต่าง 
ๆ ของโปรแกรม ใน Photoshop มีพาเนลอยูเ่ป็นจ านวนมาก เช่น พาเนล Color ใชส้ าหรับเลือกสี, 
พาเนล Layers ใช้ส าหรับจดัการกบัเลเยอร์ และพาเนล Info ใช้แสดงค่าสีตรงต าแหน่งท่ีช้ีเมาส์
รวมถึงขนาด/ต าแหน่งของพื้นท่ีท่ีเลือกไว ้
รายละเอียดแต่ละเมนู ใน Menu Bar Photoshop CS5 

Menu Bar (เมนูบาร์) ประกอบดว้ยกลุ่มค าสั่งต่างๆ ท่ีใช้จดัการกบไฟล์ท างานกบัรูปภาพ
และใชก้ารปรับแต่งการท างานของโปรแกรม โดยแบ่งเมนูตามลกัษณะงาน นอกจากน้ีบางเมนูหลกั 
จะมีเมนูยอ่ยซอ้นอยูโ่ดยสังเกตจากเคร่ืองหมายซ่ึงคุณตอ้งเปิดเขา้ไปเพื่อเลือกค าสั่งภายในอีกที 
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เมนูบาร์หลกั 
 
เมนู รายละเอยีด 
File รวมค าส่ังทีใ่ช้จัดการกบัไฟล์รูปภาพ เช่น สร้างไฟล์ใหม่, เปิด, ปิด, บันทกึไฟล์, 

น าเข้าไฟล์,ส่งออกไฟล์ และอ่ืน ๆ ทีเ่กี่ยวกบัไฟล์ 
Edit รวมค าส่ังทีใ่ช้ส าหรับแก้ไขภาพ และปรับแต่งการท างานของโปรแกรมเบื้องต้น 

เช่น ก๊อปป้ี, วาง, ยกเลกิค าส่ัง , แก้ไขเคร่ืองมือ และอ่ืน ๆ 
Image รวมค าส่ังทีใ่ช้ปรับแต่งภาพ เช่น สี, แสง, ขนาดของภาพ (image size), ขนาด

ของเอกสาร(canvas), โหมดสีของภาพ, หมุนภาพ และอ่ืน ๆ 
Layer รวมค าสังทีใ่ช้จัดการกบัเลเยอร์ ทั้งการสร้างเลเยอร์, แปลงเลเยอร์ และการจัดการ

กบัเลเยอร์ในด้านต่าง ๆ 
Select รวมค าส่ังเกีย่วกบัการเลือกวัตถุหรือพืน้ทีบ่นรูปภาพ (Selection) เพ่ือน าไปใช้

งานร่วมกบัค าส่ังอ่ืน ๆ เช่น เลือกเพ่ือเปลีย่นสี, ลบ หรือใช้เอฟเฟ็กต์ต่างๆ กบั
รูปภาพ 

Filter รวมค าส่ังทีใ่ช้ปรับแต่ง และสร้างเอฟเฟ็กต์พเิศษให้กบัรูปภาพ 
3D รวมค าส่ังทีใ่ช้กบัภาพแบบ 3 มิติ(มีเฉพาะในเวอร์ช่ันPhotoshopCs5Extended) 
View ใช้ปรับแต่งการแสดงผลของส่วนประกอบต่าง ๆ ในหน้าจอของโปรแกรม เช่น 

ไม้บรรทดั,เส้นกริด และการยอ/ขยายมุมมองของภาพเป็นต้น 
Analsis เคร่ืองมือวดัค่าและวเิคราะห์การท างาน(มีเฉพาะในเวอร์ช่ัน Photoshop Cs5 

Extended) 

Window 
มี เมนูค าส่ังทีเ่กี่ยวข้องกบการแสดงผลของหน้าตั้งภาพ, ซ่อน/แสดงเคร่ืองมือ 
และพาเนลต่าง ๆ ทีใ่ช้ท างาน เช่น เปิด/ปิด แถบเคร่ืองมือ, พาเนล, จัดพืน้ที ่ฯลฯ 

Help เรียกดูค าอธิบายในการท างานต่าง ๆ ของเคร่ืองมือหรือค าสังภายในโปรแกรม 
 
ตั้งค่าคีย์บอร์ดชอร์ตคัทใน Photoshop CS5 
  คีย์บอร์ดชอร์ตคัท คือ การก าหนดคีย์ส าหรับเรียกใช้ค าส่ังต่าง ๆ ภายในโปรแกรมได้อย่าง
รวดเร็วแทนการเรียกใช้ค าส่ังจากเมนูหรือทูลบาร์ โดยปกติโปรแกรมจะตั้งค่ามาให้แล้วแต่ เรา
สามารถแก้ไขหรือเปลีย่นแปลงปุ่มบนคีย์บอร์ดได้ตามต้องการโดยมีข้ันตอนดังนี้ 
 วธีิตั้งค่าคีย์บอร์ดชอร์ตคัท (Keyboard Shortcuts)  

1. เลือกค าส่ัง Edit > Keyboard Shortcuts 
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รูปที ่2.28 วธีิตั้งค่าคียบ์อร์ดชอร์ตคทั 

2. คลิกเลือกเมนูท่ีตอ้งการก าหนดคียล์ดัใหม่ 

3. ก าหนดคียล์ดัหลกั และตอ้งไม่ซ ้ ากบัคียอ่ื์น ๆ ท่ีใชอ้ยู ่

 4. เม่ือก าหนดเสร็จแลว้ก็คลิก OK 
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รูปที ่2.29 รูปการเปิด-ปิด Panel 

การเปิด-ปิด Panel ต่างๆ ใน Photoshop CS5 

วธีิการเปิด Panel  การเปิดพาเนลใด ๆ ข้ึนมาใชง้านนั้นสามารถท าไดห้ลายวธีิดงัน้ี 

วธีิที ่1 เลือกเปิดจากเมนู Window 

 - เลือกค าสั่ง Window เลือก Panel ท่ีตอ้งการเปิด หรืออาจจะกดคียล์ดัก็ได ้ซ่ึงแสดงอยหูลงั

ช่ือแต่ละ Panel 

 

รูปที ่2.30 รูปเลือกเปิดจากเมนู Window 
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วธีิที ่2 

  -คลิกเปิด/ปิดพาเนล จากไอคอนท่ีแสดงอยบูนแถบพาเนลท่ีพบัเก็บ 

  -คลิกท่ีช่ือแถบพาเนลท่ีซอ้นกนัอยูซ่ึ่งอาจจะอยูใ่นกลุ่มเดียวกนั 

 

รูปที ่2.31 รูปคลิกเปิด/ปิดพาเนล จากไอคอนท่ีแสดงอยบูนแถบพาเนลท่ีพบัเก็บ 

วธีิการปิดPanel 

 วธีิที ่1 

  - เลือกค าสัง่ Window >คลิกท่ีช่ือ Panel ท่ีตอ้งการปิด 

 วธีิที ่2 

  -คลิกขวาบนแถบช่ือพาเนล แลว้เลือก Close 
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รูปที ่2.32 คลิกขวาบนแถบช่ือพาเนล แลว้เลือก Close 

 

วธีิที ่3 
 -คลิกท่ีเมนูของพาเนล แลว้เลือก Close หรือ Close Tab Group ได ้

การเปิดไฟล์ภาพทีม่ีอยู่เข้า Photoshop 
Photoshop มีคุณสมบติัเด่นท่ีสามารถเปิดไฟล์รูปภาพประเภทต่าง ๆ ได้สารพดัรูปแบบ 
เช่น GIF,JPG, TIF, BMP, PNG และอ่ืนๆ รวมทั้ งไฟล์ PSD ซ่ึงเป็นรูปแบบพื้นฐานของ 
Photoshop เองวธีิเปิดไฟลท์ าไดด้งัน้ี 
1.เลือกค าสัง่ File > Open (หรือกดคียล์ดั Ctrl+O) 

 

 

รูปที ่2.33 รูปการเปิดไฟลภ์าพท่ีมีอยูเ่ขา้ Photoshop 
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2. ในช่อง Look in เลือกไดรว ์และโฟลเดอร์ท่ีจดัเก็บไฟล ์

3. ดูตวัอยา่งภาพ และคลิกเลือกช่ือไฟลจ์ากรายการ (กด Shift หรือ Ctrl ช่วยเลือกหลาย ๆ 

ไฟลไ์ด)้ 

4. คลิกปุ่ม Open 

 

 

รูปที ่2.34 รูปการเปิดไฟลภ์าพท่ีมีอยูเ่ขา้ Photoshop 

ถ้าต้องการเปิดไฟล์ภาพล่าสุดทีเ่พงิใช้ไปไม่นาน ซ่ึงจะช่วยลดเวลาการหาภาพในเคร่ืองของเราได้ มี

วธีิการดังนี้ 

 - ไปท่ีค าสัง่ File > Open Recent >เลือกไฟลภ์าพท่ีตอ้งการ 
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รูปที ่2.35 รูปการเปิดไฟลภ์าพท่ีมีอยูเ่ขา้ Photoshop 

 
เปิดไฟล์แบบ Smart Object ใน Photoshop CS5 

หากเราเปิดไฟลภ์าพข้ึนมา แลว้ตอ้งการปรับยอ่-ขยายขนาดของภาพบนเลเยอร์โดยให้
รักษาความคมชดัของภาพจากการปรับ ก็เลือกเปิ ดไฟลภ์าพแบบ Open As Smart Object ได ้ซ่ึงจะ
เหมาะส าหรับภาพบิทแมพท่ีตอ้งการเปิ ดมาแกไขขนาดของภาพ ่้ หรือการเปิดไฟลภ์าพเวคเตอร์ 
เช่น Al หรือPDF ดงัน้ี 
วธีิการเปิดไฟล์แบบ Smart Object 
1.เลือกค าสั่ง File > Open As Smart Object 

 

 
 
 

รูปที ่2.36 รูปเปิดไฟลแ์บบ Smart Object ใน Photoshop CS5 
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2. เลือกต าแหน่งท่ีเก็บไฟลภ์าพ 
3. คลิกเลือกไฟลภ์าพ 
 4. คลิก Open 
 

 
 

รูปที ่2.37 รูปเปิดไฟลแ์บบ Smart Object ใน Photoshop CS5 

 

 
 

รูปที ่2.38 รูปเปิดไฟลแ์บบ Smart Object ใน Photoshop CS5 
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เปิดไฟล์ซ้อนบนเลเยอร์ ใน Photoshop CS5 
หากเราตอ้งการเปิดไฟลภ์าพข้ึนมาหลาย ๆ ภาพในไฟลเ์ดียว เพื่อน ามาคดัเลือกหรือตดัต่อ

ภาพ อาจจะใชว้ธีิเปิดภาพแบบเลเยอร์ คือใหเ้ปิดไฟลภ์าพ 1 ไฟลต่์อ 1 เลเยอร์ท าใหเ้ราไม่ตอ้งมานงั
ก็อปป้ีใหเ้สียเวลาก็จะใชค้  าสั่ง Load file into Stack ไดด้งัน้ี 
วธีิเปิดไฟล์ซ้อนบนเลเยอร์ 
 
1.เลือกค าสัง่ File > Script > Load File into Stack 
 

 
 

รูปที ่2.39  รูปเปิดไฟลซ์อ้นบนเลเยอร์ ใน Photoshop CS5 
 
 

2. คลิกปุ่ม Browse... ไปเลือกไฟลภ์าพท่ีเปิดข้ึนในเลเยอร์ (เลือกทีละหลาย ๆ ไฟลไ์ด)้ 
3. คลิกปุ่ม OK 
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รูปที ่2.40  รูปเปิดไฟลซ์อ้นบนเลเยอร์ ใน Photoshop CS5 
 

4.ก็จะเห็นไฟลรู์ปภาพท่ีเลือกแสดงอยใูนเลเยอร์ต่าง ๆ 
 

 
 

รูปที ่2.41  รูปเปิดไฟลซ์อ้นบนเลเยอร์ ใน Photoshop CS5 
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การสร้างไฟล์กราฟิกใหม่ใน Photoshop CS5 
  เราสามารถสร้างไฟล์กราฟิกใหม่วาง ๆไวส้ าหรับออกแบบภาพกราฟิกเพื่อน าไปใช้งาน 
เองหรือน าภาพอ่ืน ๆ มาตดัต่อไดด้งัน้ี 
วธีิการสร้างไฟล์กราฟิกใหม่ 

1.เลือกค าสั่ง File > New (หรือกดคียล์ดั Ctrl+N) 
 

 
 

รูปที ่2.42  รูปวธีิการสร้างไฟลก์ราฟิกใหม่ 
 

2. ตั้งช่ือไฟลใ์หม่ในช่อง Name (หรือจะเก็บไวต้ั้งตอนสั่งบนัทึกไฟลก่์อน ได)้  
3. ก าหนดความกวา้ง  x สูง ของภาพ โดยใส่ค่า แลว้เลือกหน่วย เช่น 
 - Width: ก าหนดความกวา้งของภาพ  
 - Height : ก าหนดความสูงของภาพ  
4. ก าหนดคุณสมบติัของภาพ  
 - Resolution: ความละเอียดของภาพ 
 > ส าหรับเวบ็เพจใช ้72 pixels/inch 
 > ส าหรับส่ิงพิพมท่ี์ตอ้งการความละเอียดสูงใช ้300 pixels/inch 
 - Color Mode : เลือกโหมดสีของภาพ โดยทัว่ไปใช ้RGB Color แบบ 8 bit 
 5. เลือกลกัษณะของพื้นหลงั 
 - White : ใหพ้ื้นหลงัมีสีขาว 
 - Background Color : ใหพ้ื้นหลงัเป็นสี Background ตามท่ีเรากาหนด  
 - Trasparent : ใหพ้ื้นหลงัโปร่งใส (โปรแกรมจะแสดงเป็นตารางหมากรุกใหเ้ฉย ๆ) แต่ 
ลกัษณะจะไม่มีค่าสีใด ๆ 
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 6. ก าหนดโปรไฟล์สี และสัดส่วนพิกเซล (หากไม่เห็นออปชัน่กลุ่มน้ี ให้คลิกปุ่มดงัภาพ
ก่อน) 
 - Color Profile โปรไฟลสี์ของภาพ ส าหรับรูปภาพทัว่ไปใหใ้ช ้ sRGB 
 - Pixel Aspect Ratio สัดส่วนกวา้ง/สูงของพิกเซล โดยทัว่ไปใช ้่่ Square Pixels 
 
 
 

 

 
 

 
รูปที ่2.43  รูปวธีิการสร้างไฟลก์ราฟิกใหม่ 
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การ Copy ไฟล์ (Duplicate File) Photoshop CS5 
 การเปิดไฟล์รูปภาพต้นฉบับข้ึนมาแก้ไขเปล่ียนแปลงใด ๆ หากเราใช้ค  าสั่ ง Save 

โปรแกรมก็จะน าภาพท่ีแกไ้ขล่าสุดบนัทึกของเดิมโดยอตัโนมติัท าให้ไม่สามารถเรียกไฟล์ตน้ฉบบั
เดิมกลบัมาใชง้านไดอี้กดงันั้นเพื่อความปลอดภยัของภาพ เราควรท าส าเนาหรือก๊อปป้ีไฟลข้ึ์นมาอีก
ไฟลห์น่ึง เพื่อใชแ้กไ้ขโดยเฉพาะ หรือใชเ้ปรียบเทียบกบัภาพเดิมไดด้งัน้ี 

วธีิการ Copy ไฟล์ (Duplicate File) 
1.เลือกค าสั่งImage > Duplicate 

 

 
 

รูปที ่2.44  รูปวธีิการ Copy ไฟล ์(Duplicate File) 
 

2. ตั้งช่ือไฟลใ์หม่ 
  3. คลิกปุ่ ม OK 

 
 

รูปที ่2.45  รูปวธีิการ Copy ไฟล ์(Duplicate File) 
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การบันทกึไฟล์ภาพใน Photoshop CS5 
  การเปิดไฟล์ภาพข้ึนมาตกแต่งหรือแก้ไขด้วย Photoshop นั้น เม่ือสร้างหรือตกแต่งภาพ
เสร็จแลว้ เราจะตอ้งบนัทึกไฟล์ดว้ยเพื่อเก็บการเปล่ียนแปลงท่ีท ากบัภาพ โดยเลือกบนัทึกไฟล์ได้
หลายรูปแบบข้ึนอยูก่บัวตัถุประสงคข์องการน าไปใชง้านส าหรับไฟล์ประเภทแรกท่ีควรบนัทึกคือ 
รูปแบบ PSD ของ Photoshopเอง เพื่อเก็บเป็นตน้ฉบบัไวส้ าหรับน ามาแกไ้ขในภายหลงัจากนั้นจึง
สั่งบนัทึกไฟล์เป็นประเภทอ่ืน เช่น GIFหรือ JPG เพื่อให้เหมาะส าหรับการน าไปใช้งานในแต่ละ
กรณี 
 
บันทกึไฟล์ Photoshop (.PSD) 
 
  การแกไ้ขไฟล์ภาพโดยการสร้างกราฟิกเพิ่มการตดัต่อ หรือเปล่ียนแปลงลกัษณะของไฟล์
ภาพท่ีมีผลกบัโครงสร้างเดิมของภาพ ่ั เม่ือเลือกค าสั่ง  File > Save จะแสดงไดอะล็อกบอ็กซ์ Save 
As ข้ึนมาโดยจะเลือกรูปแบบของไฟลเ์ป็น Photoshop (*.PSD, *.PDD) เป็นค่าพื้นฐานดงัน้ี 
 ** คุณสมบติัของไฟล์PSD จะเก็บรายละเอียดการท างานต่าง ๆ เช่น เลเยอร์, ฟอนต ์และเส้นพาธไว ้
ไดอ้ยางครบถว้นช่วยให้การน าไฟล์ภาพกลบัมาแกไ้ขท้  าไดง่้ายในขณะท่ีไฟล์ประเภทอ่ืนจะเก็บ
ขอ้มูลเหล่าน้ีไม่ได ้หรือไดเ้พียงบางส่วน 
 
บันทกึไฟล์ทบัของเดิม 
  การเปิดไฟล์ภาพมาตกแต่งสี, แสงเงา หรือก าหนดค่าเอฟเฟ็กตใ์ห้กบัภาพ แต่ไม่ไดใ้ชค้  าสั่ง
เก่ียวกบัการสร้างเลเยอร์ (เลเยอร์ คือ ชั้นท่ีจดัวางรูปภาพ) หรือสร้างกราฟิกอ่ืน ๆ เพิ่มเติมในภาพ 
เม่ือเลือกค าสั่ง  File> Save โปรแกรมจะใหบ้นัทึกทบัช่ือไฟลเ์ดิม รูปแบบเดิม 
 (จะไม่ไดอ้ะล็อกบ๊อกซ์ Save As เปิดข้ึนมา หากไม่ตอ้งการให้ทบัไฟล์เดิม ตอ้งคลิกเลือกค าสั่งFile 
> Save As เอง)บนัทึกเป็นไฟล์รูปแบบอ่ืน ๆนอกจากการบนัทึกเป็นไฟล์ .psd และบนัทึกลงใน
รูปแบบของไฟล์ตน้ฉบบัเดิมแล้วยงับนัทึกไฟล์ภาพเก็บไวใ้นรูปแบบอ่ืน ๆ ได้ตามตอ้งการ โดย
คลิกเลือกค าสั่ง File > Save As แล้วเลือกรูปแบบของไฟล์ในช่อง Format ซ่ึงจะมีรูปแบบไฟล์ให้
เลือกหลายแบบดงัภาพ 
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รูปที ่2.46  รูปบนัทึกไฟลท์บัของเดิม 
 

 
 

รูปที ่2.47  รูปบนัทึกไฟลท์บัของเดิม 
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บันทกึไฟล์ทบัของเดิม 
  การเปิดไฟล์ภาพมาตกแต่งสี, แสงเงา หรือการก าหนดค่าเอฟเฟ็กต์ให้กบัภาพแต่ไม่ไดใ้ช้
ค  าสั่งท่ีเก่ียวกบัการสร้างเลเยอร์ (เลเยอร์ คือ ชั้นท่ีจดัวางรูปภาพ) หรือสร้างกราฟิกอ่ืน ๆ เพิ่มเติมใน
ภาพ เม่ือเลือกค าสั่ง File> Save โปรแกรมจะให้บันทึกทับช่ือไฟล์เดิม  รูปแบบเดิม (จะไม่ได้
อะล็อกบ๊อกซ์ Save As เปิ ดข้ึนมา หากไม่ตอ้งการให้ทบัไฟล์เดิม ต้องคลิกเลือกค าสัง ่่ File > 
Save As เอง) 
บันทกึเป็นไฟล์รูปแบบอ่ืน ๆ 
  นอกจากการบนัทึกเป็นไฟล์ .psd และบนัทึกลงในรูปแบบของไฟล์ตน้ฉบบัเดิมแล้วยงั
บนัทึกไฟล์ภาพเก็บไวใ้นรูปแบบอ่ืน ๆ ได้ตามต้องการ โดยคลิกเลือกค าสั่งFile > Save As แล้ว
เลือกรูปแบบของไฟลใ์นช่อง Format ซ่ึงจะมีรูปแบบไฟลใ์หเ้ลือกหลายแบบดงัภาพ 

 
 

รูปที ่2.48  รูปบนัทึกเป็นไฟลรู์ปแบบอ่ืน ๆ 
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บันทกึไปใช้กบัเวบ็เพจหรืออุปกรณ์อ่ืน 
  รูปภาพท่ีน าไปใช้กบัเวบ็เพจจะต่างจากรูปภาพท่ีน าไปใช้กบังานดา้นอ่ืน ๆ คือ ชนิดของ
ภาพท่ีจะน าไปใชบ้นเวบ็เพจนั้น ตอ้งเป็น GIF, JPG หรือ PNG เท่านั้น และควรให้ไฟล์มีขนาดเล็ก 
ขนาดภาพตอ้งพอดี ไม่ใหญ่จนเกินไป เม่ือผูช้มเปิดเขา้ไปในเวบ็ไซต์จะไดโ้หลดภาพไดเ้ร็วยิ่งข้ึน 
โปรแกรมจึงมีค าสั่งส าหรับบนัทึกรูปภาพไปใชใ้นเวบ็เพจโดยเฉพาะ คือ Save for Web & Devices 
โดยค าสังน้ีจะใหก้ าหนดค่าออปชนัการบนัทึกภาพประเภทต่าง ๆ พร้อมกบดูภาพตวัอยา่งขนาดของ
ไฟลแ์ละระยะเวลาในการดาวน์โหลดเปรียบเทียบกนไดอี้กดว้ย ดงัน้ี 

1.เลือกค าสัง ่่ File > Save for Web & Devices 

 
 

รูปที ่2.49  รูปบนัทึกไปใชก้บัเวบ็เพจหรืออุปกรณ์อ่ืน 
 

2. ก าหนดออปชัน่นต่าง ๆ ในการแปลงไฟล์ แลว้ดูภาพ ขนาด และเวลาในการดาวน์โหลด
เปรียบเทียบกนัในไดอะล็อกบอ็กซ์  Save for Web & Devices ดงัภาพหนา้ 
 3. เลือกภาพจากกรอบตวัอยา่งท่ีตอ้งการใชง้าน 
 4. คลิกปุ่ม Save เพื่อบนัทึกภาพ 
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รูปที ่2.50  รูปบนัทึกไปใชก้บัเวบ็เพจหรืออุปกรณ์อ่ืน 
 

5. บนไดอะล็อกบ๊อกซ์ Save Optimized As เลือกต าแหน่งโฟลเดอร์ท่ีจะจดัเก็บในช่อง 
Save in 

  6. ก าหนดช่ือไฟลภ์าพในช่อง File name 
  7. คลิกปุ่ม Save 

 
 

รูปที ่2.51  รูปบนัทึกไปใชก้บัเวบ็เพจหรืออุปกรณ์อ่ืน 
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Layer คืออะไร 
 ส าหรับการตดัต่อภาพ ส่ิงท่ีมีความจ าเป็นคือการน าเอาเคร่ืองมือต่างๆ ของ Photoshop มา

ใช้งานร่วมกน และส่ิงท่ีส าคญัอย่างยิ่ง คือ่ Layer (เลเยอร์) ท่ีจะช่วยให้เราจดัวางรูปภาพท่ีน ามา
ประกอบกนัเพื่อสร้างผลงานใหม่ออกมา Layer เปรียบเสมือนแผน่พลาสติกใส เม่ือเราวาด หรือวาง
ช้ินส่วนภาพลงบน Layerแต่ละชั้นแล้วน ามาเรียงซ้อนกนัหลาย ๆ ่ั ชั้นจะท าให้ภาพทั้งหมดดู
เหมือนเป็นช้ินเดียวกน โดยภาพใน ่ั Layerบนจะบงั Layer ท่ีอยูด้านล่างเสมอ ยกเวน้บริเวณท่ี
โปร่งใสซ่ึงจะมองทะลุไปเห็นภาพใน Layer ถดัๆ ลงไปได ้

 - Layer ช่ือ Background จะเป็น Layer ของไฟล์ภาพท่ีสร้างใหม่ หรือเปิดรูปภาพ
ข้ึนมา 
 - Layer ช่ือ Layer 1, Layer 2, … คือ เลเยอร์ท่ีสร้างเพิ่ม หรือ  Copy ภาพมาวางเพิ่ม 
 

 
 

 
 

รูปที ่2.51  รูป Layer 
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ประโยชน์ของ Layer คือ 
 ช่วยให้เราแกไขภาพเฉพาะส่วนใดส่วนหน่ึงไดง่้าย เช่น การยา้ยต าแหน่ง, การปรับขนาด, 

ปรับสี/แสงเงา ซ่ึงจะท าไดอ้ยา่งอิสระจากกนั้นนอกจากน้ีเรายงัสามารถสลบัล าดบัและซ่อน/แสดง 
Layer แต่ละชั้นท าให้ทดลองจดัองคป์ระกอบภาพแบบต่างๆ ไดห้ลากหลายก่อนท่ีจะเลือกภาพชุด
สุดทา้ยท่ีจะน าไปใชจ้ริง 
พาเนล Layersพาเนล Layers  

เป็นเคร่ืองมือหลักท่ีใช้จดัการกบ ่ั Layer ไม่วาจะเป็นการ เพิ่ม/ลบ Layer, การเปล่ียน
ล าดบั, การปรับความโปร่งใส เป็นตน้ เม่ือเราจะใช ้Layer เราตอ้งระวงัวาค าสั่งต่าง ๆ ส่วนใหญ่จะมี
ผลต่อภาพใน Layer ท่ีกาลงัเลือกเท่านั้น ดงันั้นจะตอ้งสังเกต และเลือกเลเยอร์ท่ีถูกตอ้งก่อนการ
ท างานใด ๆ 
ข้อดี 

1. มีความยดืหยุน่ของเคร่ืองมือในการท างานมาก 
2. มีเคร่ืองมือ รวมถึง Filter ต่างๆ มากมายใหเ้ลือกให ้
3. มีเคร่ืองมือส าหรับเปิดไฟลล์ RAW (Adobe RAW)ซ่ึงนักถ่ายภาพมืออาชีพใช้กัน 
และมีรายละเอียดท่ีครบถว้น 
4. สามารถปรับ Profile สี ให้เขา้กนัดว้ย รวมถึงมี Adobe RGB ท่ีเป็นสากลทัว่โลกใช้
กนั(ก็ของค่ายเคา้น่ี) 
5. สามารถใชง้านแบบ Layer ได ้
6. สามารถใช ้Plug-in เสริม รวมกบั โปรแกรมอ่ืนได ้
7. สามารถใชง้านร่วมกบัหลายโปรแกรมจากค่าย Adobe ได ้เช่น Premiere, Illustrator 
8. สามารถเปิดภาพ และเซฟไฟลล ์ไดห้ลายนามสกุล 
9. สามารถ Slice ภาพ ออกเป็นภาพย่อยๆ และเซฟเป็นเว็บได้ทันที โดยไม่ต้องใช้
โปรแกรมอ่ืนๆช่วยท า 
10. รองรับ WIA จากแสกนเนอร์ สามารถ สั่งแสกน จากไดรเวอร์แสกนเนอร์ และ 
Import ภายในโปรแกรมเลย(ไม่ตอ้งแสกนแยก และ Import ทีหลงั) 

ข้อเสีย 
1. มีราคาแพง 
2. กินทรัพยากรเคร่ืองสูง 
3. ยงัคงมีปัญหาสระลอย ในภาษาไทย(ไม่รู้ CS3 แกแ้ลว้หรือยงั) 
4. บงัคบัลง Adobe Bridge ซ่ึงคนท่ีไม่ใช่ Photograph คงไม่ไดใ้ชแ้น่ๆเลย 
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โครงการทีเ่กีย่วข้อง 

นายพิชญะ พึ่ งพกัตร์ นายสหัสวรรษ ตูจิ้นดา และนายเอกทวีป ไชยกูล (2561) โครงการ
เวบ็ไซต์โครงการความรู้ไทยแลนด์ 4.0 จดัท าข้ึนเพื่อพฒันาเวบ็ไซต์ท่ีเป็นแนวทางในการศึกษา
โครงการความรู้ไทยแลนด์ 4.0 และน าไปเป็นความรู้ได้ ซ่ึงมีขอบเขตการศึกษาคือ มีออกแบบ 
Banner และ Logo มีการสร้างเมนูเช่ือมโยงเอกสาร โดยมีโปรแกรมท่ีใช้คือโปรแกรม Adobe 
Dreamweaver CS5.5 และ โปรแกรม Adobe Photoshop CS5 

 นายพชัรพล นิพาภรณ์ นายณัฐกานต ์ทองบางพึ่งและนายสรยุทธ์ รักสวน (2561) โครงการ
เว็บไซต์ส่ือการเรียนการสอนวิชาการอ่านส่ือส่ิงพิมพ์ในชีวิตประจ าวนัเพื่อให้ผูท่ี้สนใจศึกษา
เก่ียวกบัส่ือส่ิงพิมพ์ในชีวิตประจ าวนัหรือผูท่ี้อยากรู้เก่ียวกบัการอ่านส่ือส่ิงพิมพน์ั้น ไดรั้บความรู้
ต่าง ๆ ท่ีมีอยูใ่นการอ่านส่ือส่ิงพิมพใ์นชีวติประจ าวนัไม่มากก็นอ้ย 
 นายพงษ์พฒัน์ เหลืองหลีกภยั นางสาวอาทิตยา ผลาเสพและนายนครินทร์ ศิลป์ชยั(2561) 
โครงการเวบ็ไซต์การดูแลรักษารถยนตเ์บ้ืองตน้เพื่อประกอบการเรียนการสอนในห้องเรียนและให้
ขอ้มูลทัว่ไปเพื่อให้บุคคลท่ีศึกษาไดน้ าขอ้มูลมาใช้ให้เกิดประโยชน์เพื่อให้บุคคลทัว่ไปได้ศึกษา
เก่ียวกับการดูแลรักษารถยนต์ขอบเขตมีการออกแบบหน้า Index และ Home ของเว็บไซต์มีการ
ออกแบบ Site Map และ Logo เว็บไซต์มีรูปภาพประกอบบนเว็บไซต์ โปรแกรมท่ีจดัท า Adobe 
Dreamweaver CS5.5 ใช้ในการสร้างเวบ็ไซต์ Adobe Photoshop CS6 ใช้ในการออกแบบLogoและ
ตกแต่งรูปภาพ 
2.4 การน าระบบคอมพวิเตอร์เข้ามาใช้ในระบบ 
 1.น าคอมพิวเตอร์เขา้มาใชใ้นการท าหนา้เวบ็เพจ 

2.น าคอมพิวเตอร์เขา้มาใชใ้นการออกแบบแบนเนอร์เวบ็ไซต ์
3.น าคอมพิวเตอร์เขา้มาใชใ้นการตกแต่งเวบ็ไซต ์
4.น าคอมพิวเตอร์เขา้มาใชใ้นการหาขอ้มูล 
5.น าคอมพิวเตอร์เขา้มาใชใ้นการเผยแพร่ขอ้มูล 
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บทที ่3 
การออกแบบระบบงานด้วยคอมพวิเตอร์ 

 
3.1 การออกแบบ  Site Map 

 

 

รูปที ่3.1 Site Map 
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รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 

 



67 

 

 

 

รูปที ่3.1 Site Map (ต่อ) 

 



68 

 

 

 

รูปที ่3.1 Site Map (ต่อ) 
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รูปที ่3.1 Site Map (ต่อ) 
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3.2 การออกแบบ Story Board 

 

 

 

 

 

 

 

 

 

รูปที ่3.2  Index 
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รูปที ่3.3  Home 

 

 

 

 

 

 

 

 

 

รูปที ่3.4  หนา้ประวติั 

 

 

 

 

 

 

 

 

 

รูปที ่3.5  ขนมไทยแต่ละภาค 
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รูปที ่3.6  ภาคเหนือ 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.7  ภาคกลาง 
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รูปที ่3.8  ภาคอีสาน 

 

 

 

 

 

 

 

 

 

รูปที ่3.9  ภาคใต ้
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รูปที ่3.10  ประเภทของขนม 

 

 

 

 

 

 

 

 

 

รูปที ่3.11  ขนมประเภทไข่ 
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รูปที ่3.12  ขนมประเภทน่ึง 

 

 

 

 

 

 

 

 

 

รูปที ่3.13  ขนมประเภทตม้ 
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รูปที ่3.14  ขนมประเภทกวน 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.15  ขนมประเภทอบและผงิ 
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รูปที ่3.16  ขนมประเภททอด 

 

 

 

 

 

 

 

 

 

รูปที ่3.17  ขนมประเภทเช่ือม 
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รูปที ่3.18 ขนมประเภทฉาบ 

 

 

 

 

 

 

 

 

 

รูปที ่3.19  ขนมประเภทน ้ากะทิ 
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รูปที ่3.20  ขนมประเภทน ้าเช่ือม 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.21  ขนมประเภทบวด 
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รูปที ่3.22  ขนมประเภทแช่อ่ิม 

 

 

 

 

 

 

 

 

 

รูปที ่3.23  ขนมประเภทป้ิง 
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รูปที ่3.24  ผูจ้ดัท า 
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3.3 การออกแบบส่ิงน าเขา้  (Input  Data) 

 1. ประวติัความเป็นมาของขนมไทย 

 2. ขนมไทยแต่ละภาค 

  2.1 ภาคเหนือ 

  2.2 ภาคกลาง 

  2.3 ภาคอีสาน 

  2.4 ภาคใต ้

 3. ความรู้เพิ่มเติม 

  3.1 ความรู้เก่ียวกบัเวบ็ไซต ์

  3.2 ความรู้เก่ียวกบัขนมไทย 

3.4 การออกแบบส่ิงน าออก  (Output Data) 

 1. แสดงออกทางหนา้จอคอมพิวเตอร์ในรูปแบบของเวบ็ไซต์ 

 2. แสดงออกทางเคร่ืองฉายโปรเจคเตอร์เพื่อน าเสนอการสร้างเวบ็ไซต์ 

 



 

บทที ่4 
การพฒันาระบบเวบ็ไซต์ขนมไทย 

 
4.1     เคร่ืองมือและอุปกรณ์ทีใ่ช้ 

1. Intel(R) Core(TM) i5-7th Gen  CPU @ 1.80GHz  1.80 GHz 
2. NVIDIA  on Board 
3. HDD 1  TB 
4. Intel  on  Board 
5. Notebook  DELL Inspiron 14 7000 
6. Mouse  OKER 
7. Keyboard  MD tech 
8. Printer  HP 
9. Flash drive King ton 32 GB 

 
4.2    โปรแกรมทั้งหมดทีใ่ช้พฒันา 

1. โปรแกรม Adobe Dreamweaver CS6  ใชใ้นการท าเวบ็ไซต ์
2. โปรแกรม Adobe Photoshop CS6  ใชใ้นการตกแต่งรูปภาพ 
3. โปรแกรม Microsoft Office Word 2010 ใชใ้นการท าเอกสาร 
4. โปรแกรม Microsoft Office PowerPoint 2010 ใชใ้นการท างานน าเสนอ 
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4.3  วธีิการติดตั้งโปรแกรม 
 
 
 
 
 
 
 
 
 
 
 
 
    รูปที ่4.1  หนา้ Desktop 
 
 
 
 

 

 
 
 
 
 
 
 
    รูปที ่4.2  คลิกท่ี This PC 
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รูปที ่4.3  คลิกท่ี KINGSTON E 

 
 

 
 
 
 
 
 
 
 
 
 
 

รูปที ่4.4  คลิกท่ี เวบ็ไซตข์นมไทย 
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รูปที ่4.5 คลิกท่ี Index เพื่อเขา้หนา้เวบ็ไซตแ์รกของเรา 
 

4.4 วธีิการใช้งานเวบ็ไซต์ 
 

 
 
 
 
 
 
 
 

 
 

รูปที ่4.6  เปิดโปรแกรมเวบ็บราวเซอร์และพิมพ ์ E:/เวบ็ไซตข์นมไทย/ Index 
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รูปที ่4.7  แสดงหนา้จอรูปท่ี  1  หนา้เขา้สู่ระบบ ( Index ) 

 
 
 
 
 

 
 
 
 
 

 
 

รูปที ่4.8  แสดงหนา้จอรูปท่ี  2  หนา้หลกัของระบบ (Home) 
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  รูปที ่4.9  แสดงหนา้จอรูปท่ี  3  History 
 
 
 
 
 
 
 

 
 

 
 

 
 

    รูปที ่4.10  แสดงหนา้จอรูปท่ี  4  Sweets in each region 
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รูปที ่4.11  แสดงหนา้จอรูปท่ี  5  ภาคเหนือ 
 
 

 
 
 
 
 
 
 
 

 
 

รูปที ่4.12  แสดงหนา้จอรูปท่ี  6  ภาคกลาง 
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รูปที ่4.13  แสดงหนา้จอรูปท่ี  7  ภาคอีสาน 

 
 

 
 
 
 
 
 
 
 

 
 

รูปที ่4.14  แสดงหนา้จอรูปท่ี  8  ภาคใต ้
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รูปที ่4.15  แสดงหนา้จอรูปท่ี  9  ขนมแต่ละภาค 
 
 

 
 
 
 
 
 
 
 

 
 

 
รูปที ่4.16  แสดงหนา้จอรูปท่ี  10  ขนมประเภทไข่ 
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    รูปที ่4.17  แสดงหนา้จอรูปท่ี  11  ขนมประเภทน่ึง 
 

 
 

 
 
 
 
 
 
 
 
 

รูปที ่4.18  แสดงหนา้จอรูปท่ี  12  ขนมประเภทตม้ 
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รูปที ่4.19  แสดงหนา้จอรูปท่ี  13  ขนมประเภทกวน 
 

 
 
 
 
 
 
 
 
 

 
 
 

รูปที ่4.20  แสดงหนา้จอรูปท่ี  14  ขนมประเภทอบและผงิ 
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รูปที ่4.21  แสดงหนา้จอรูปท่ี  15  ขนมประเภททอด 
 
 
 

 
 
 
 
 
 
 

 
 
 

รูปที ่4.22  แสดงหนา้จอรูปท่ี  16  ขนมประเภทเช่ือม 
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รูปที ่4.23  แสดงหนา้จอรูปท่ี  17  ขนมประเภทฉาบ 

 

 
 
 
 
 
 
 
 
 

 
 

รูปที ่4.24  แสดงหนา้จอรูปท่ี  18  ขนมประเภทน ้ากะทิ 
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รูปที ่4.25  แสดงหนา้จอรูปท่ี  19  ขนมประเภทน ้าเช่ือม 
 
 
 

 
 
 
 
 
 
 
 
 

รูปที ่4.26  แสดงหนา้จอรูปท่ี  20  ขนมประเภทบวด 
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รูปที ่4.27  แสดงหนา้จอรูปท่ี  21  ขนมประเภทแช่อ่ิม 
 
 
 

 
 
 
 
 
 
 
 

 
 

รูปที ่4.28  แสดงหนา้จอรูปท่ี  22  ขนมประเภทป้ิง 
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รูปที ่4.29  แสดงหนา้จอรูปท่ี  23  ขนมประเภท Provider 
 



 

 

บทที ่5 
สรุปผลการท าโครงการ 

 
5.1 สรุปผลโครงการ 

1. ไดเ้วบ็ไซตท่ี์ผูศึ้กษานั้นมีความรู้ความเขา้ใจและรู้จกัขนมไทยมากข้ึน 
2. ไดเ้วบ็ไซตท่ี์ผูใ้ชส้ามารถทราบถึงวิธีการท าขนมไทยไดอ้ยา่งถูกตอ้ง    
3. ไดเ้วบ็ไซตท่ี์ผูส้นใจไดท้ดสอบความรู้และความเขา้ใจของตนเองได้ 
4. ไดเ้วบ็ไซตท่ี์ผูใ้ชส้ามารถน าความรู้ท่ีไดไ้ปประยกุตใ์ชใ้นชีวติประจ าวนั 
5.  ไดเ้วบ็ไซตท่ี์ผูใ้ชน้ั้นสามารถเผยแพร่ความรู้เก่ียวกบัการท าขนมไทยไดอ้ยา่งถูกตอ้ง 

 
5.1.1 สรุปขนาดของโปรแกรม  

ที่ ช่ือไฟล์ ขนาดของไฟล์ หมายเหตุ 
1 Index.html 3 KB หนา้แรกของเวบ็ไซต ์
2 Home.html 9 KB หนา้หลกัของเวบ็ไซต ์
3 History.html 6 KB หนา้ประวติัความเป็นมา 
4 Sweets in each region.html 8 KB หนา้ขนมไทยแต่ละภาค 
5 Northern.html 8 KB หนา้ภาคเหนือ 
6 Central.html 8 KB หนา้ภาคกลาง 
7 Isan.html 8 KB หนา้ภาคอีสาน 
8 Southern.html 8 KB หนา้ภาคใต ้
9 Types of thai desserts.html 20 KB หนา้ขนมแต่ละประเภท 

10 Types of thai desserts2.html 20 KB หนา้ขนมแต่ละประเภทขอ้ท่ี 2 
11 Egg type.html 16 KB หนา้ขนมประเภทไข่  
12 Steaming type.html 24 KB หนา้ขนมประเภทน่ึง 
13 Boiled type.html 21 KB หนา้ขนมประเภทตม้ 
14 Stirring type.html 17 KB หนา้ขนมประเภทกวน 

 
 

ตารางที ่5.1 แสดงขนาดของโปรแกรม 
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 5.1.1 สรุปขนาดของโปรแกรม 

 
ตารางที ่5.1 แสดงขนาดของโปรแกรม  (ต่อ) 

 
5.1.2 สรุปข้อผดิพลาดทีม่ีต่อการออกแบบระบบงาน 

1.  สัญลกัษณ์ Logo ไม่ตรงกบัท่ีรูปแบบตอนแรก มีการเปล่ียนแปลงรูปทรง
เพื่อใหส้วยงามมากข้ึน 

  2.  โครงสร้างโปรแกรมบางส่วนมีขนาดไม่เหมาะสมและดูไม่เขา้กบัเน้ือหา 
  3.  เกิดความขดัแยง้ทางความคิดเห็นในรูปแบบของโปรแกรมจากเดิม 
  4.  เพื่อหลงัของโปรแกรมเรียบเกินไป ท าใหดู้ไม่น่าสนใจ จึงตอ้งเพิ่มเติมลวดลาย   
 ใหม่ 

5.1.3 สรุปข้อผดิพลาดทีม่ีในโปรแกรม 
  1.  โลโกใ้นเวบ็ไซตไ์ม่แสดง 

2.  รูปภาพในเวบ็ไซตไ์ม่มีแสดง ตอ้งหารูปภาพใหม่มาแกไ้ข 
3.  ตวัอกัษรในเวบ็ไซต ์มีขนาดเล็กใหญ่ไม่เท่ากนั 

  4.  ไฟลโ์ปรแกรมชอบ Link สลบักนัไปมา 
  5.  เช่ือมฐานขอ้มูลส าเร็จ แต่ไม่สามารถเรียกใชง้านได ้
  6.  เม่ือน าฐานขอ้มูลไปเช่ือมต่อกบัเคร่ืองเซิฟเวอร์อ่ืน จะมีฐานขอ้มูลซ ้ ากนัท าให้ 
 ขอ้มูลไม่ ตรงกนักบัโปรแกรม 
  7.  Link VDO  ท่ีน ามาลงในโปรแกรม บางไฟลไ์ม่สามารถเล่นได ้

15 Baking type.html 16 KB หนา้ขนมประเภทอบและผงิ 
16 Fried type.html 17 KB หนา้ขนมประเภททอด 
17 Welding type.html 20 KB หนา้ขนมประเภทเช่ือม 
18 Putty type.html 16 KB หนา้ขนมประเภทฉาบ 
19 Coconut milk type.html 19 KB หนา้ขนมประเภทน ้ากะทิ 
20 Syrup types.html 15 KB หนา้ขนมประเภทน ้าเช่ือม 
21 Types of urry ordainel.html 16 KB หนา้ขนมประเภทบวด 
22 Crystallized type.html 15 KB หนา้ขนมประเภทแช่อ่ิม 
23 Toasting type.html 16 KB หนา้ขนมประเภทป้ิง 
24 Provider.html 9 KB หนา้สมาชิกในกลุ่ม 
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5.1.2 สรุปข้อผดิพลาดทีม่ีต่อการออกแบบระบบงาน 
1.  สัญลกัษณ์ Logo ไม่ตรงกบัท่ีรูปแบบตอนแรก มีการเปล่ียนแปลงรูปทรง

เพื่อใหส้วยงามมากข้ึน 
  2.  โครงสร้างโปรแกรมบางส่วนมีขนาดไม่เหมาะสมและดูไม่เขา้กบัเน้ือหา 
  3.  เกิดความขดัแยง้ทางความคิดเห็นในรูปแบบของโปรแกรมจากเดิม 
  4.  เพื่อหลงัของโปรแกรมเรียบเกินไป ท าใหดู้ไม่น่าสนใจ จึงตอ้งเพิ่มเติมลวดลาย   
 ใหม่ 

5.1.3 สรุปข้อผดิพลาดทีม่ีในโปรแกรม 
  1.  โลโกใ้นเวบ็ไซตไ์ม่แสดง 

2.  รูปภาพในเวบ็ไซตไ์ม่มีแสดง ตอ้งหารูปภาพใหม่มาแกไ้ข 
3.  ตวัอกัษรในเวบ็ไซต ์มีขนาดเล็กใหญ่ไม่เท่ากนั 

  4.  ไฟลโ์ปรแกรมชอบ Link สลบักนัไปมา 
  5.  เช่ือมฐานขอ้มูลส าเร็จ แต่ไม่สามารถเรียกใชง้านได ้
  6.  เม่ือน าฐานขอ้มูลไปเช่ือมต่อกบัเคร่ืองเซิฟเวอร์อ่ืน จะมีฐานขอ้มูลซ ้ ากนัท าให้ 
 ขอ้มูลไม่ ตรงกนักบัโปรแกรม 
  7.  Link VDO  ท่ีน ามาลงในโปรแกรม บางไฟลไ์ม่สามารถเล่นได ้
  8.  ปุ่มตวัอกัษรบางตวัมีภาพและสีท่ีคลา้ยคลึงกบัพื้นหลงัโปรแกรมท าใหไ้ม่ค่อย 
 ชดัเจน 
5.2  ปัญหาและอุปสรรค์ในการด าเนินงาน 
 1.  คอมพิวเตอร์มีอาการช ารุด หนา้จอคา้ง ตอ้งเปล่ียนมาใช ้Note Book  ในการท างานแทน 
 2.  โปรแกรม Adobe Photoshop คา้ง ไม่สามารถตกแต่งรูปภาพได ้ตอ้งซ้ือแผน่มาลงใหม่ 
 3.  สมาชิกในกลุ่มมีเวลาในการท างานไม่ตรงกนั 
 4.  เคร่ืองพิมพเ์อกสารหวัพิมพช์ ารุดและหมึกพิมพแ์ตกระหวา่งท างาน 
 5.  การติดต่อส่ือสารระหวา่งกลุ่มไม่ต่อเน่ืองท าใหง้านล่าชา้และผดิแผนท่ีวางไว ้
 6.  แบ่งเวลางานไม่ดี ท าให้โปรแกรมเสร็จชา้และไม่สมบูรณ์เท่าท่ีควร 
 7. สมาชิกในกลุ่มไม่ยอมช่วยงาน 
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5.3 สรุปการด าเนินงานจริง   
 

รายการ ภาคเรียนที่ 1 มิถุนายน 62 กรกฎาคม 62 สิงหาคม 62 กนัยายน 62 
ระยะเวลา 

1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 
อบรมการท าโครงการนกัศกึษา ปวช.3 
และ ปวส.2                 11-12 มิถนุายน 62 

เสนอหวัข้อ ATC.01 โครงการรอบที่ 1 
เอกสารบทท่ี 1 

                
14 มิถนุายน 62 

ประกาศผลหวัข้อ รอบที่ 1                 17 มิถนุายน 62 

เสนอหวัข้อโครงการ รอบที่ 2                 19 มิถนุายน 62 

ประกาศผลหวัข้อ รอบที่ 2                 21 มิถนุายน 62 

ลงทะเบยีนหวัข้อออนไลน์เสนอ
อาจารย์ที่ปรึกษาร่วม 

                
18-30 มิถนุายน 62 

สง่เอกสารบทท่ี 2                 8-14 กรกฎาคม 62 

สง่เอกสารบทท่ี 3                 15-31 กรกฎาคม 62 

สอบน าเสนอโครงการ (รอบเอกสาร)                 17 สงิหาคม 62 

ประกาศผลสอบ (รอบเอกสาร)                 22 สงิหาคม 62 

สง่ความคืบหน้าโปรแกรม 50%                 9-15 กนัยายน 62 

สง่ความคืบหน้าโปรแกรม 60%                 16-22 กนัยายน 62 

สง่ความคืบหน้าโปรแกรม 70%                 23-30 กนัยายน 62 

รายการ ภาคเรียนที่ 2 
พฤศจิกายน 62 ธันวาคม 62 มกราคม 63 กมุภาพนัธ์ 63 

ระยะเวลา 
1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 4 

สง่ความคืบหน้าโปรแกรม 90%                 1-8 พฤศจิกายน 62 

สง่ความคืบหน้าโปรแกรม 100%                 9-13 พฤศจิกายน 62 

สอบน าเสนอโครงการ ระดบัปวช.3                 
7 ธันวาคม 62 

ประกาศผลสอบ (รอบโปรแกรม)                 
11 ธันวาคม 62 

สง่เอกสารบทท่ี 4                 
6-19 มกราคม 63 

สง่เอกสารบทท่ี 5                 
20-26 มกราคม 63 

สง่งบประมาณในการท าโครงการ 
(แบบออนไลน์) 

                
26-30 มกราคม 63 

สง่รูปเลม่ ซีดี ช าระค่าเข้าเลม่                 
1-20 กมุภาพนัธ์ 63 

 
ตารางที ่5.2 สรุปเวลาการด าเนินงานจริง 

หมายเหตุ  เส้นสีด า คือ ระยะเวลาท่ีก าหนดn  
   เส้นสีแดง คือ ระยะเวลาในการด าเนินงานจริง 
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5.4 สรุปค่าใช้จ่ายในการด าเนินการจริง 
ล าดับ รายการ จ านวน ราคา (บาท) 

1 กระดาษ A4 1 รีม 240 
2 ค่าปร้ิน 1 รีม 600 
3 ค่ารวมเล่ม 1 เล่ม  200 
4 ค่าCD 2 แผน่ 40 

รวมเป็นเงิน 1,100 

 
 

ตารางที ่5.3 สรุปค่าใชจ่้ายในการด าเนินงานจริง 
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ภาคผนวก 
- ใบเสนอขออนุมติัการท าโครงการระบบคอมพิวเตอร์ธุรกิจ   (ATC.01) 
- ใบอาจารยท่ี์ปรึกษาร่วม    (ATC.02) 
- ใบขอสอบป้องกนัโครงการระบบคอมพิวเตอร์ธุรกิจ  (ATC.03)  
- รายงานความคืบหนา้โครงการระบบคอมพิวเตอร์ธุรกิจ (AT.C.04)   
- ใบบนัทึกการเขา้พบอาจารยท่ี์ปรึกษาโครงการ (AT.C.05) 
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